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Wwise	Unity	Integration:

Wwise	Unity	Integration	2017.2.0.6500.947
2017.2
	2017.2

Wwise	Unity	Integration	2017.1.4.6407.845
Wwise	Unity	Integration	2017.1.3.6377.812
Wwise	Unity	Integration	2017.1.2.6361.791
Wwise	Unity	Integration	2017.1.1.6340.770
Wwise	Unity	Integration	2017.1.0.6302.726

2017.1
	2017.1

Wwise	Unity	Integration	2016.2.4.6098.531
Wwise	Unity	Integration	2016.2.3.6077.504
Wwise	Unity	Integration	2016.2.2.6022.430
Wwise	Unity	Integration	2016.2.1.5995.409
Wwise	Unity	Integration	2016.2.1
Wwise	Unity	Integration	2016.2.0
Wwise	Unity	Integration	2016.1.3
Wwise	Unity	Integration	2016.1.2
Wwise	Unity	Integration	2016.1.1
Wwise	Unity	Integration	2016.1
Wwise	Unity	Integration	2015.1.4
Wwise	Unity	Integration	2015.1.3
Wwise	Unity	Integration	2015.1.2
Wwise	Unity	Integration	2015.1.1
Wwise	Unity	Integration	2015.1
Wwise	Unity	Integration	2014.1.6
Wwise	Unity	Integration	2014.1.5
Wwise	Unity	Integration	2014.1.4
Wwise	Unity	Integration	2014.1.3
Wwise	Unity	Integration	2014.1.2
Wwise	Unity	Integration	2014.1.1
Wwise	Unity	Integration	2014.1
Wwise	Unity	Integration	2013.2.9
Wwise	Unity	Integration	2013.2.8



Wwise	Unity	Integration	2013.2.5
Wwise	Unity	Integration	2013.2.4
Wwise	Unity	Integration	2013.1.1
Wwise	Unity	Integration	2013.1



Wwise	Unity	Integration	2017.2.0.6500.947
Wwise	2017.2.0Wwise	SDKUnity	2017.3

Wwise	SDK:	2017.2.0
UnityUnity	5.55.62017.12017.22017.3	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	
Mac
Windows Unity	2017.3.0f3

Android
iOS
Linux
PS4
tvOS
UWP	(
Windows	)
Xbox	One

Unity	2017.2.0f3

Switch Unity	for	Nintendo	Switch	3.1.2	(Unity	5.6.4
with	NintendoSDK	3.5.2)

:

2017.2	

breaking	changes 	2017.2

:

WG-25994:	C#	 Using	the	Audio	Input	Source
Plug-in	in	Unity.	
WG-27337:	MIDI	 Sending	MIDI	to	Wwise.	



WG-28541:	AkAk
WG-33501:	SoundBank
WG-34446:	AkCallbackManager



Wwise	Unity	Integration	2017.1.4.6407.845

Wwise	SDK:	2017.1.4
UnityUnity	5.55.62017.12017.2	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
UWP	(
Windows	)
Windows
Xbox	One

Unity	2017.2.0f3

Switch Unity	for	Nintendo	Switch	3.1.2	(Unity	5.6.4
with	NintendoSDK	3.5.2)

:

WG-35168:	Switch
WG-35383:	WwiseTypesID
WG-35384:	AkAudioListener AkInitializer AkTerminator Awake()

OnEnable()Editor 	WG-35513:	AkGameObj
WG-35958:	Unity	2017.3Unity	2017.3



Wwise	Unity	Integration	2017.1.3.6377.812
Wwise	2017.1.3Wwise	SDKUnity	2017.1

Wwise	SDK:	2017.1.3
UnityUnity	5.55.62017.12017.2	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Windows
Xbox	One

Unity2017.2.0f3

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)

:

WG-34855:	AkSoundEngine.GetCurrentLanguage()
WG-35075:	:	Unity	2017.2Wwise	Launcher



Wwise	Unity	Integration	2017.1.2.6361.791
Wwise	2017.1.2Wwise	SDK

Wwise	SDK:	2017.1.2
Unity:	Unity	2017.1	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Windows
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)



Wwise	Unity	Integration	2017.1.1.6340.770
Wwise	2017.1.1Wwise	SDKUnity	2017.1

Wwise	SDK:	2017.1.1
Unity:	Unity	2017.1	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	
Mac
Windows Unity	2017.1.0f3

Android
iOS
Linux
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)

:

WG-33018:	:	Decode	Banks
WG-33818:	iOSAndroid
WG-34090WSA	Unity	PluginTLS	Allocator	Error
WG-34188:	System.EventHandlerfully	qualified	name)
WG-34205:	UnityEditor.MenuUnityEditor.MenuItemfully
qualified	name)



Wwise	Unity	Integration	2017.1.0.6302.726
Wwise	2017.1.0Wwise	SDKUnity	2017.1

Wwise	SDK:	2017.1.0
Unity:	Unity	2017.1	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	
Mac
Windows Unity	2017.1.0f3

Android
iOS
Linux
PS4
PS	Vita
tvOS
UWP	(	Windows
)
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1	with
Nintendo	SDK	1.4.0)

:

2017.1	

Wii	U
GameObjectUnity	Integration	Extensions Wwise	Installation
and	Migration	Guide
AkCallbackManager	 	2017.1 	

:

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


WG-27479:	 AkInitializer

WG-30791:	WwiseTypes	 WwiseTypes	
WG-31155	 AkMemSettings		 AkChannelConfig	
SoundEngine
WG-31735	GameObject	 Unity	Integration	
WG-32348SoundBanksInfoXML
WG-32657	 foreach	
WG-33303AK_MusicPlaylistSelect
WG-34003:	



Wwise	Unity	Integration	2016.2.4.6098.531
Wwise	2016.2.4Wwise	SDK

Wwise	SDK:	2016.2.4
Unity:	Unity	5.6	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	
Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(
Windows	)
Xbox	One

Unity	5.6.1p1

Switch Switch	1.0.1	Unity	(Unity	5.5.0p1
with	Nintendo	SDK	1.4.0)

:

WG-33395:	



Wwise	Unity	Integration	2016.2.3.6077.504
Wwise	2016.2.3Wwise	SDK

Wwise	SDK:	2016.2.3
Unity:	Unity	5.6	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.6.0f3

Switch Unity	for	Switch	0.6.1
Wii	U Unity	5.4.2f2

:

WG-32536:	Nintendo	Switch

WG-32623:	Android



Wwise	Unity	Integration	2016.2.2.6022.430
Wwise	2016.2.2Wwise	SDK

Wwise	SDK:	2016.2.2
Unity:	Unity	5.5	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.5.0p4

Wii	U Unity	5.4.2f2

:

WG-31862:	enum



Wwise	Unity	Integration	2016.2.1.5995.409
Wwise	2016.2.1Wwise	SDK

Wwise	SDK:	2016.2.1
Unity:	Unity	5.5	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.5.0f3

Wii	U Unity	5.4.2f2

:

WG-32006:	GameObject"Unknown	Game	Object	ID"



Wwise	Unity	Integration	2016.2.1
Wwise	2016.2.1Wwise	SDK

Wwise	SDK:	2016.2.1
Unity:	Unity	5.5	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.5.0f3

Wii	U Unity	5.4.2f2

:

WG-27085:	AuxSends
WG-31127:	AK_MusicSyncUserCue
WG-31650:	SoundEngineAkGameObjFixed
NullReferenceException
WG-31651:	SetObjectPositionAkGameObj
WG-31862:	enum

Unity	case	#861189:	Unity	Windows	StoreLauncher

https://fogbugz.unity3d.com/default.asp?861189_deb0tebbc8rt0vl0


Wwise	Unity	Integration	2016.2.0
Wwise	2016.2.0Wwise	SDK

Wwise	SDK:	2016.2.0
Unity:	Unity	5.4	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration

Android
iOS
Linux
Mac
PS4
PS	Vita
tvOS
Windows
Windows	Store	(	Windows	
)
Xbox	One

Unity	5.4.1p2

Wii	U Unity	5.2.4f1

Windows	Phone	8.1Windows	Store	8.08.13
Windows	StoreUniversal	Windows	Platform	(UWP)	
Xbox	360	
PS3	

:

WG-30571:	LibraryWwise	Unity	Integration



WG-30960:	AkGameObjUnity
WG-31507:	DurationMediaIDbStreaming



Wwise	Unity	Integration	2016.1.3
Wwise	2016.2.3Wwise	SDK

Wwise	SDK:	2016.1.3
Unity:	Unity	5.4	(PersonalPro)

Note:	:	Integration	Unity	4	Unity	4Wwise
Integration	Unity

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
tvOS
Windows
Windows	Store
Xbox	One

Unity	5.4.0p2

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1



Wwise	Unity	Integration	2016.1.2
Wwise	2016.1.2Wwise	SDKWwise	Unity

Wwise	SDK:	2016.1.2
Unity:	Unity	5.4	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
tvOS
Windows
Windows	Store
Xbox	One

Unity	5.4.0p2

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1

:

WG-30567	Fixed:	WAV

SWIGzipzipSWIG
SWIG
Wwise	2014.1.42016.12015.1.6



2016.1
UnityUnity	5.4Wwise	2016.1.2	Unity	5.4Wwise
2016.1.2



Wwise	Unity	Integration	2016.1.1
Wwise	2016.1.1Wwise	SDK

Wwise	SDK:	2016.1.1
Unity:	Unity	5.3	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
tvOS
Windows
Windows	Store
Xbox	One

Unity	5.3.5p6

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1

:

WG-30021:	SoundBankSoundBank
WG-30228:	Linux
WG-30231:	tvOS
WG-30259:	GC.Collect	 AkGameObj	

:

WG-30128:	VitaSoundBank



WG-30139:	Wii	USoundBank



Wwise	Unity	Integration	2016.1
Wwise	2016.1Wwise	SDK

Wwise	SDK:	2016.1
Unity:	Unity	5.3	(PersonalPro)

Note:	:	Unity
4

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
Windows
Windows	Store
Xbox	One

Unity	5.3.4p3

Wii	U Unity	5.2.4f1
Xbox	360 Unity	5.0.1f1

:

WG-25675	:	WwiseSoundBankWwise	Picker
"Generate	SoundBanks"
WG-27583	Fixed:	UnitySoundBankUnity
SoundBank
WG-28175	:	WwiseGlobal
WG-26011	:	SceneAK	Audio	ListnerDefault	Unity	Audio
Listener



SWIGzipzipSWIG
SWIG
Wwise	2014.1.42016.12015.1.6
2016.1

:

WG-30021:	EditorDecodeBanks
WG-30021:	DecodeBanksSoundBankSoundBank
DecodedBanks
WG-30128:	VitaSoundBank
WG-30139:	WiiUSoundBank



Wwise	Unity	Integration	2015.1.4
Wwise	2016.1Wwise	SDK

Wwise	SDK:	2015.1.4
Unity:	Unity	4.6	ProUnity	5.2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PS	Vita
Windows
Windows	Phone
Xbox	One

Unity	5.2.2p1

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

WG-28412	:	 AkGameObj	Prefab
WG-28723	:	PS4



Wwise	Unity	Integration	2015.1.3
Wwise	2015.1.3Wwise	SDKUniversal	Windows	Platform

Wwise	SDK:	2015.1.3
Unity:	Unity	4.6	ProUnity	5.2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
PS3
PS4
PS	Vita
Windows
Windows	Store	Apps
Xbox	One

Unity	5.2.2p1

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

Universal	Windows	PlatformWindows	Store	Apps
Windows	Store	Apps	SDK	8.1
Windows	Phone	8.0
Windows	Store	Apps	SDK	8.0

:

WG-25945	:	WwiseUnityWwiseGlobalWwise
Unity
WG-26011	:	SceneAK	Audio	ListnerDefault	Unity	Audio
Listener
WG-28108	:	EditorEditor



WG-28175	:	WwiseGlobal
WG-28479	:	SetupMain	Camera
Setup
WG-28526	:	Unity	EditorGameObjectsSoundEngine



Wwise	Unity	Integration	2015.1.2
Wwise	2016.1Wwise	SDK

Wwise	SDK:	2015.1.2
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PS	Vita
Windows
Windows	Phone
Xbox	One

Unity	5.2.0f3

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

WG-27029	:	Unity	GameObject	 AkGameObj

WG-28200	:	Everything(0,	0,	0)GameObject3D
L0



Wwise	Unity	Integration	2015.1.1
Wwise	2015.1.1Wwise	SDK

Wwise	SDK:	2015.1.1
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PS	Vita
Windows
Windows	Phone
Xbox	One

Unity	5.1.2p2

Wii	U Unity	4.3.7f1Wii	U2.2.5
Xbox	360 Unity	5.0.1f1

:

WG-27977	:	Unity
WG-28030	:	Wii	U/Unity:	Release	RPLTRCNDEBUG
WG-28042	:	Unity:	Wwise
WG-28044	:	Unity:	Wwise
WG-28046	:		 AkInitializer	
WG-28048	:	Wwise	ProfilerGameObject



Wwise	Unity	Integration	2015.1
Wwise	2015.1Wwise	SDK

Wwise	SDK:	2015.1

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor

:

WG-27079	Fixed:	WwiseSettings.xml



Wwise	Unity	Integration	2014.1.6
Wwise	2014.1.6Wwise	SDK

Wwise	SDK:	2014.1.6
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PSVita
Windows
Windows	Phone

Unity	5.0.2p3

Xbox	360 Unity	5.0.1f1
Xbox	One Unity	5.0.2p4

:

WG-27585	Fixed:	Wwise	PickerWwise
WG-27624	Fixed:	(PS3)	SetListenerPostionPS3

Unity:

Xbox	One:	UnitySoundEngine
Unity	4Windows	Store	Apps:	 DllNotFoundException

unity_troubleshooting

:

WG-27585	Fixed:	Wwise	PickerWwise



Wwise	Unity	Integration	2014.1.5
Wwise	2014.1.5Wwise	SDK

Wwise	SDK:	2014.1.5
Unity:	Unity	4.6.5	ProUnity	5.1.2p2	(Personal		Pro)

Wwise	Unity	Integration	

Android
iOS
Linux
Mac
Metro
PS3
PS4
PSVita
Windows
Windows	Phone

Unity	5.0.2p3

Xbox	360 Unity	5.0.1f1
Xbox	One Unity	5.0.2p4

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor

Unity:

Xbox	One:	UnitySoundEngine
Unity	4Windows	Store	Apps:	 DllNotFoundException

unity_troubleshooting

:

Android	x86
Windows	Store	AppsScripting	Define	Symbols



:

WG-27108	Fixed:	DestroyUnity
WG-25733	Fixed:	WindowsiOS/Mac
WG-26875	Fixed:	AkMemBankLoader



Wwise	Unity	Integration	2014.1.4
Wwise	2017.1.1Wwise	SDKUnity	2017.1

Wwise	SDK:	2014.1.4
Unity:	Unity	4	ProUnity	5	PersonalPro

:

WG-26780	Fixed:	WwiseUnity
WG-26837	Fixed:	AkBankManager

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac

:

Windows	Phone	8.1Metro
Unity	5Wwise	Unity	IntegrationPlugin	Importer	API

<UNITY_PROJECT_ROOT>/Assets/Plugins

--	: 	Unity	4Unity	5:

1.	
2.	 Unity	4Unity	5Unity	--	-#	Unity	52014.1.4

Unity
3.	 "Start"
4.	
5.	 Unity	5Wwise	Unity	Integration



Wwise	Unity	Integration	2014.1.3
Wwise	2014.1.3Wwise	SDK

Wwise	SDK:	2014.1.3

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2014.1.2
Wwise	2014.1.2Wwise	SDK

Wwise	SDK:	2014.1.2
Unity	Editor	(October	XDK)	Wwise	SDK	(November	XDK)	XDK
Xbox	One

:

WG-26305	Fixed:	Null64-bit
WG-26337	Fixed:	Mac	64-bit
WG-26385	Fixed:	AndroidWwiseUnityCPU
WG-26395	Fixed:	MSBUILDWindows	Phone	8
WG-26430	Fixed:	iOSSetBasePath()

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2014.1.1
	Wwise	2014.1.1Wwise	SDK

Wwise	SDK:	2014.1.1
Unity:	4.x	5.0

:

Wii	U
Plug-in	Registration
Unity	"Wwise	Settings"Wwise
GeneratedSoundBanksPopulate

:

WG-26201:	C#	System	:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2014.1
Wwise	2014.1Wwise	SDK2013.2	Wwise
Unity	Integration

--	

2013.2	Wwise	Unity	Integration

Wwise	SDK:	2014.1
Unity:	4.x

--	

Android
iOS
Linux*

32-bit
64-bit

Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows	Phone	8.0
Xbox360
Xbox	One

:



Wwise 	
2013.2	Wwise	Unity	Integration
WwiseWwise	Unity	IntegrationUUIDWwiseUnity

Adding	New	Triggers	for	Wwise	Events	
Wwise AkAmbientInspector	
AkSoundEngine
WwiseGlobalAkListener

:

WG-25783:	Callback	Manager
WG-25677:	Mac

:

WG-25669:	Wwise	PickerAuto	PopulateMac	Editor
WG-25733:	WindowsiOS/Mac



Wwise	Unity	Integration	2013.2.9
Wwise	2013.2.9Wwise	SDK

--	 	--	:

Wwise	SDK:	2013.2.9
Unity:	4.x

--	

Android
iOS
Linux*

32-bit
64-bit

Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows	Phone	8.0
Xbox360
Xbox	One

:

Windows	Phone	8.0



Wwise	Unity	Integration	2013.2.8
	Wwise	2013.2.8Wwise	SDKWwise-Unity

--	

Unity
Wwise	PickerWwise Wwise	Picker
Unity Wwise	Unity	Integration	Wwise	2015.1
Wwise	SDK

Wwise	SDK:	2013.2.8
Unity:	4.x

--	

Android
iOS
Linux*

32-bit
64-bit

Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows	Phone	8.0
Xbox360
Xbox	One



:

Xbox	One
PS4
Linux
*	Unity	Integration	for	LinuxWwise	2013.2.8	Linux	BETA
Windows	Phone	8.0

WindowsMetroUnityScripting	Define	Symbol

IntegrationUnity	Editor
Integration
Windows	IDEVisual	Studio	20082010
WindowsMetro



Wwise	Unity	Integration	2013.2.5
Wwise	2013.2.5Wwise	SDK

Wwise	SDK:	2013.2,	2013.2.x
Unity:	4.x

--	

Android
iOS
Mac	OS	X	(10.6	)
PS3
PS4
PS	Vita
Windows

32-bit
64-bit

Windows	8	(Metro)

IntelARMWindows	Store	App
Xbox	360
Xbox	One

:

:	PS4
:	PS	Vita
:	Xbox	One
Android:	API	 AddBasePath()I/OPOSIX

:

WG-24351:	iOS:	



Wwise	Unity	Integration	2013.2.4
Wwise	2013.2.4Wwise	SDK

Wwise	SDK:	2013.2,	2013.2.x
Unity:	4.x

--	

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows

32-bit
64-bit

Mac	OS	X	(10.6	)
iOS
Android
Xbox360
PS3

:

Integration Wwise	>	Help
Wwise	SDKVersion.txt

:

WG-24080:	Windows	APIMac	APIAndroid

Android	armeabi



Wwise	Unity	Integration	2013.2.1
	Wwise	2013.2.1Wwise	SDK

Wwise	SDK:	2013.2,	2013.2.1
Unity:	4.x3.x

--	

Windows	8	(Metro)

IntelARMWindows	Store	App
Windows

32-bit
64-bit

Mac	OS	X	(10.6	)
iOS
Android
Xbox360
PS3

:

Unity	IntegrationUnityUnity
Editor
WwiseUnity	EditorUI:

SoundBank	ID	C++	C#
Unity	4Scripting	Define	SymbolsWindows

IntegrationDemo
Android:	SoundBankAndroid	Expansion	Files	(OBB)

:

http://docs.unity3d.com/Documentation/Components/class-PlayerSettings40.html
http://developer.android.com/google/play/expansion-files.html


WG-23781:	Bank
WG-23734:	WindowsMarker
WG-23345:	Unity	Editor
WG-23436:	Unity:	
WG-23423:	UnityGameObject
WG-22533:	Unity:	API

iOS

Unity 	
	 	
iOSXcodeAPI Build	for	iOS	
UI
Apple
SWIG2.0.11MacSWIGpg_compileswig

https://www.audiokinetic.com/library/2015.1.9_5624/?source=Unity&id=pg__howtobuildmultiarch.html


Wwise	Unity	Integration	2013.1.1
Wwise	2016.1Wwise	SDKIntegration



Wwise	Unity	Integration	2013.1
Wwise	2013.1Wwise	SDKAndroid

Wwise	SDK:	2012.2.x,	2013.1
Unity:	3.4.x,	3.5.x,	4.x

--	

Windows	8

IntelARMWindows	Store	App
Windows	(32bit)
Windows	(64bit)
Mac	OS	X	(10.6	)
iOS
Android
Xbox360
PS3

:

Android:	SoundBanksAndroid	(apk)	LoadBank()
API
Windows	64bit
Windows	8

: 	WG-22948:	PS3

WG-22938:	Mac	OSXUnity	Integration
WG-22334:	UnityMusic	userCue
WG-22329:	Unity	IntegrationPostEvent()
WG-22255:	Unity	Android:	
WG-22165:	3DiOSAndroid
WG-21933:	AkCallbackManager.csfloatUserCue
WG-21365:	Unity	iOS:	iOS



WG-22533:	API

1UnityWindowsMac

quietverbose
Python
IntegrationUnity

Integration	for	PS3Visual	Studio	2010
Python	2.6Python	2.7.x3.x
IntegrationUNITY_PROJECT_ROOTIntegration
UNITY_PROJECT_ROOT
Plug-in	from	Source
AndroidPostprocessBuildPlayerUnity
IntegrationDemoUnity4
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2017.2
Wwise	2017.2Unity	Integration:

Edit	Mode
Edit

WwiseGlobal
Wwise	Audio	Input
MIDI
Automatic	SoundBank	Management



Edit	Mode
WwiseUnityEditPlayWwise AkEvent	(
AkAmbient)	The	Play/Stop	button	plays	and	stops
individual	Events.	When	multiple	objects	that	have	AkEvents	are
selected,	the	Play	Multiple	and	Stop	Multiple	buttons	play	or	stop	all
currently	selected	Events.	The	Stop	All	button	stops	all	currently	playing
Events.

Edit

EditAkBankLoad	On:AwakeUnload	On:Never



WwiseGlobal
WwiseGlobalAkEditorEventPlayerEdit
AkEventWwiseEventsWwiseGlobal
AkGameObj AkAudioListenerEdit AkEnvironment AkGameObj AkRoom

	pg_installprojectchange		 sect_audio_input_scripts	Wwise
Audio	Input	Wwise	Audio	InputC#	
Source	Plug-in	in	Unity.	



MIDI
WwiseMIDIC#	 Sending	MIDI	to	Wwise.	



Automatic	SoundBank	Management
SoundBank	 Deploying	SoundBanks	in	single-platform	projects
	 Deploying	SoundBanks	in	multi-platform	projects



Spatial	Audio
UnityAPI	 	
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	2017.2
:

Pre-2017.2: New	in	2017.2:
ErrorCode AK.Monitor.ErrorCode

ErrorLevel AK.Monitor.ErrorLevel

DynamicSequenceType AK.SoundEngine.DynamicSequence.DynamicSequenceType

MultiPositionType AK.SoundEngine.MultiPositionType

PreparationType AK.SoundEngine.PreparationType

RTPCValue_type AK.SoundEngine.Query.RTPCValue_type

:

Pre-2017.2: New	in	2017.2:
Iterator AkIterator

Playlist AkPlaylist

PlaylistItem AkPlaylistItem
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2017.1
Wwise	2017.1Unity	Integration:

WwiseTypes
Unity	Integration
3D	Busses



[RequireComponent(typeof(AkGameObj))]	 AkEvent

AkEnvironment		 AkEnvironmentPortal		 Rigidbody	
Rigidbody	 AkEnvironmentAkEnvironmentPortalno

Rigidbody AkGameObj"Environment	aware" RigidbodyEditor :
AkGameObj-AkEnvironment	interactions	require	a	Rigidbody
component	on	the	object	or	the	environment.AkGameObj-
AkEnvironmentRigidbody

WwiseSettings Show	Warning	for	Missing	RigidBody



WwiseTypes
"WwiseTypes"WwiseEventSwitchesStates
Wwise

:

public	class	Footsteps	:	MonoBehaviour

{

				[Header("Wwise	Types")]

				public	AK.Wwise.Event	FootStepEvent	=	null;

				public	AK.Wwise.RTPC	SpeedRTPC	=	null;

				public	AK.Wwise.Switch	UnderFootMaterialSwitch	=

	null;

				public	AK.Wwise.Bank	FootStepBank	=	null;

				void	InitializeSound()	{	FootStepBank.Load();	}

				void	FinalizeSound()	{	FootStepBank.Unload();	}

				void	PlayFootStepSound(float	speed)

				{

								SpeedRTPC.SetValue(gameObject,	speed);

								UnderFootMaterialSwitch.SetValue(gameObject)

;

								FootStepEvent.Post(gameObject);

				}

}



Unity	Integration
AkSoundEngine	Launcher

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


3D	Busses
Wwise3D AkGameObj

AkAudioListener	 AkGameObj		 AkAudioListener	
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	2017.1
AkCallbackManager

AkCallbackManager.AudioInterruptionCallback()	h	
public	delegate	AKRESULT	AudioInterruptionCallba

ck(bool	in_bEnterInterruption,	object	in_Cookie)

;

AkCallbackManager.BGMCallback()	has	a	new	signature:
public	delegate	AKRESULT	BGMCallback(bool	in_bOt

herAudioPlaying,	object	in_Cookie);

AkCallbackManager.EventCallback()	has	a	new	signature:
public	delegate	void	EventCallback(object	in_coo

kie,	AkCallbackType	in_type,	AkCallbackInfo	in_i

nfo);

AkCallbackManager 	AkCallbackInfoC++

gameObjID 	ulong	 IntPtr

	 AkCallbackManager.AkMidiEventCallbackInfo	
AkMIDIEventCallbackInfo"MIDI"
AkCallbackManager.AkMusicSyncCallbackInfoBase

AkMusicSyncCallbackInfo
AkCallbackManager.AkMusicSyncCallbackInfo.segmentInfo

AkMusicSyncCallbackInfo.segmentInfo_*
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Unity
WwiseUnityIntegration	UnityPackageUnityWwiseUnity
Editor

Wwise	Integration	Package
Unity

SoundBank

Wwise	Integration	Package
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Wwise:	

Unity:

Platform Required	components
Unity	5	PersonalPro

iOS Xcode	4.2	or	above	with	compatible	iOS	SDK
Linux libSDL2	(See	Linux)
Windows DirectX	End-User	runtime

The	x64	Visual	Studio	2013	redistributable

Windows	32-bit	Debug

The	x86	Visual	Studio	2013	redistributable
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Wwise	Integration	Package
Wwise	Launcher Wwise	Launcher	WwiseUnity

Warning:		

LauncherUnity
WwiseUnity(Warning)
UnityUnity

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


Unity	Integration
Launcher
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Unity
Unity

Edit	>	Project	Settings	>	AudioDisable	Audio

"Create	WwiseGlobal	GameObject""Wwise
Global"Wwise	
The	WwiseGlobal	object	is	also	given
AkEditorEventPlayer,	AkAudioListener	and	AkGameObj	scripts
which	are	used	for	previewing	AkEvent	objects	in	edit	mode.	A
Rigidbody	component	is	added	such	that	interactions	between
AkEnvironment,	AkRoom	and	AkGameObj	can	also	be	previewed.
Script	Execution	OrderWwise	( AkInitializer,	AkGameObj,
AkAudioListener,	AkBank,	AkTerminator)	
"Add	Ak	Listener	to	Main	Camera"Audio	Listener
Main	Camera AkAudioListener.csMain

Play	in	BackgroundWwise	Profiler
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WwiseWwiseSoundBankWwise

1.	 WAVWindows	Explorer1Project	ExplorerAudio
Sound1

2.	 EventSound New	Event

3.	 SoundBankSoundBanksF7New
4.	 EventSoundBankEventProject	ExplorerSoundBank
5.	 Generate	SoundBanks	

Unity

1.	 Wwise	Picker		( Window	>	Wwise	Picker)Event
SoundBank

2.	 SoundBank
3.	 Event
4.	



UnityWwiseUnity

AkAmbient	
AkBank	SoundBank
AkEnvironment	Collider

--	Wwise	API2

WWISE	
	AK::SOUNDENGINE
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SoundBank
Unity	EditorSoundBankWwise GeneratedSoundBanks

Unity1 …SoundBank
WwiseSoundBankTo	avoid	packaging	the
SoundBanks	for	all	platforms	with	your	game,	you	should	enable	the
automatic	generation	of	SoundBanks	or	use	a	BuildPlayerPipeline	script.
:	 Build	your	Unity	Game	for	a	Target	Platform.
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WwiseUnitySoundBank
:

Wwise.
SoundBank
Unity
SoundBank StreamingAssetsEditor
Editor

Note:	Unity

Wwise	Compressor
Wwise	Delay
Wwise	Expander
Wwise	Gain
Wwise	Matrix	Reverb
Wwise	Meter
Wwise	Parametric	EQ
Wwise	Peak	Limiter
Wwise	RoomVerb
Wwise	Silence
Wwise	Sine
Wwise	Tone	Generator

WwiseUnity	 Creating	New	Plug-ins	

Wwise	(McDSP,	iZotope,	Auro,	SoundSeed,	Crankcase	REV,
Convolution	Reverb,	Motion)
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Wwise	Integration	Package

Warning:	

UnityUnity
UnityUnity
WwiseUnity(Warning)
C++	AkSoundEngineC++ 	Wwise	SDK	 C++
Wwise	Integration	Package

Wwise	IntegrationUnity Wwise
Integration	Package UnityWwise
IntegrationWwise	LauncherWwise
Integration

Warning:	Wwise	IntegrationWwise

2WwiseUnity



WwiseWwise
1.	 UnityWwise	IntegrationWwise
2.	 Wwise	Project
3.	 Wwise'Yes'
4.	 Wwise	SoundBankUnityWwiseOnce	completed,

make	sure	to	regenerate	your	Wwise	SoundBanks	to	be	ready	to
carry	on	with	your	work	after	updating	the	Unity	project	to	the	new
Wwise	version.



UnityWwise
UnityWwiseWwise	Launcher

Wwise	Unity	IntegrationMon	Jan	8	10:46:17	2018		 	1.6.3

http://www.doxygen.org/index.html


Wwise	Unity	Integration



Wwise	Integration	Package
Wwise	Integration	PackageUnityAssets/Wwise
Wwise
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Wwise	Unity	Integration
:

AkAmbient	Use	this	component	to	attach	a	Wwise	Event	to	any
object	in	a	scene.	The	sound	can	be	started	at	various	moments,
dependent	on	the	selected	Unity	trigger.	This	component	is	more
useful	for	ambient	sounds	(sounds	related	to	scene-bound	objects)
but	could	also	be	used	for	other	purposes.	Since	AkAmbient	has
AkEvent	as	its	base	class,	it	features	the	play/stop,	play	multiple,
stop	multiple	and	stop	all	buttons	for	previewing	the	associated
Wwise	event.	.	AkAmbientInspector	
AkAudioListener	
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to
all	game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	
AkBank	
Loads	and	unloads	a	SoundBank	at	a	specified	moment.	Vorbis
sounds	can	be	decompressed	at	a	specified	moment	using	the
decode	compressed	data	option.	In	that	case,	the	SoundBank	will	be
prepared.	
AkEmitterObstructionOcclusion	
Obstructs/Occludes	the	emitter	of	the	current	game	object	from	its
listeners	if	at	least	one	object	is	between	them.
AkEnvironment	
Use	this	component	to	define	a	reverb	zone.	This	needs	to	be	added
to	a	collider	object	to	work	properly.	AkEvironment
AkEvironmentPortalInspector	(Reverb	Zones) .	
AkEnvironmentPortal	
Use	this	component	to	define	an	area	that	straddles	two	different
AkEnvironments	zones	and	allow	mixing	between	both	zones.
AkEvironmentAkEvironmentPortalInspector	(Reverb	Zones) .	
AkEvent	
Wwise	EventUnityHelper



AkGameObj	
This	component	represents	a	sound	object	in	your	scene	tracking	its
position	and	other	game	syncs	such	as	Switches,	RTPC	and
environment	values.	You	can	add	this	to	any	object	that	will	emit
sound,	and	it	will	be	added	to	any	object	that	an	AkAudioListener	is
attached	to.	Note	that	if	it	is	not	present,	Wwise	will	add	it
automatically,	with	the	default	values,	to	any	Unity	Game	Object	that
is	passed	to	Wwise.	
AkRoom	
An	AkRoom	is	an	enclosed	environment	that	can	only	communicate
to	the	outside/other	rooms	with	AkRoomPortals.	
AkRoomPortal	
An	AkRoomPortal	can	connect	two	AkRoom	components	together.	
AkRoomPortalObstruction	
Obstructs/Occludes	the	spatial	audio	portal	of	the	current	game
object	from	the	spatial	audio	listener	if	at	least	one	object	is	between
them.	
AkSpatialAudioEmitter	
Add	this	script	on	the	GameObject	which	represents	an	emitter	that
uses	the	Spatial	Audio	API.	
AkSpatialAudioListener	
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to
all	game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	
AkState	
This	will	call	AkSoundEngine.SetState()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a
Unity	collider	to	trigger	when	an	object	enters	it.	
AkSurfaceReflector	
This	component	will	convert	the	triangles	of	the	GameObject's
geometry	into	sound	reflective	surfaces.	
AkSwitch	
This	will	call	AkSoundEngine.SetSwitch()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a
Unity	collider	to	trigger	when	an	object	enters	it.	



:
Wwise	Picker

:

AK.Wwise.AuxBus	
This	type	represents	an	auxiliary	send	in	the	Master-Mixer	Hierarchy.
AK.Wwise.Bank	
This	type	can	be	used	to	load/unload	SoundBanks.	
AK.Wwise.CallbackFlags	
This	type	represents	the	values	of	the	flags	used	when	posting	an
Event	with	a	callback.	
AK.Wwise.Event	
This	type	can	be	used	to	post	Events	to	the	sound	engine.	
AK.Wwise.RTPC	
This	type	can	be	used	to	set	game	parameter	values	to	the	sound
engine.	
AK.Wwise.State	
This	type	can	be	used	to	set	Wwise	States.	
AK.Wwise.Switch	
This	type	can	be	used	to	set	Switch	values	on	gameobjects.	
AK.Wwise.Trigger	
This	type	can	be	used	to	post	triggers	to	the	sound	engine.	

:
Wwise	Types



Wwise
3

Wwise	Picker 	EventWwise	PickerUnity	Viewer
InspectorAkAmbientGame	Object
Add	Component 	AkAmbientAkEventUnity	Game
Object
Wwise	Types	 		 AK.Wwise.Event.Post()	C#

	AKSoundEngine::SetGameObjectAuxSendValues()C#



AkAmbientInspector
AkAmbient:	

Trigger	On:	
Provides	a	list	of	Unity	events	that	can	trigger	your	event.	
AkSoundEngine.PostEvent

Adding	New	Triggers	for	Wwise	Events	
Event	Name:	
Specifies	the	name	of	the	current	event.	

Ok	Wwise	Picker
Action	On	Event:	
Enables	users	to	override	some	event	parameters	defined	in
Wwise	directly	from	Unity.	

Action	On	Event	Type:	
Overrides	the	event	type.
Curve	Interpolation:	
Overrides	the	interpolation	curve.
Fade	Time:	
Overrides	the	sound's	fade	time.

Use	Callback:	
Provides	an	easy	way	to	make	a	game	object	react	to	an	event
callback.

Game	Object:	
The	game	object	that	will	receive	the	callback.	

Callback	Function:	
This	is	the	function	that	will	get	called	by	Game	Object
when	the	callback	happens.	
Function
For	this	to	work,	Game	Object	must	define	Callback
Function	in	one	of	its	components.
The	function's	definition	must	be	void
FunctionName(AkEventCallbackMsg	in_info).
Callback	Flags:	
Select	a	flag	which	specifies	when	Callback	Function	will	be
called.	

Play	/	Stop:	



Can	be	used	to	preview	the	Wwise	Event	when	in	Edit	mode.
Stop	All:	
Stops	all	currently	playing	Wwise	events.
Position	Type:	
Defines	the	way	the	event's	position	will	be	sent	to	the	audio
engine.

Simple_Mode:	
The	event's	position	will	be	the	same	as	the	game	object	to
which	it's	attached.
Large_Mode:	
The	event	can	have	multiple	positions	that	are	defined	by	a
set	of	points.	 AkAmbient	Tool	BarAdd

MultiPosition_Mode:	
This	mode	enables	us	to	have	only	one	instance	of	a	sound
for	all	instances	of	AkAmbient	using	the	same	event	in
order	to	save	memory.	
All	AkAmbient	instances	that	are	using	this	mode	and	that
have	the	same	event	will	automatically	get	detected	and	the
same	sound	instance	will	be	used	for	all	of	them	insted	of
loading	the	same	sound	multiple	times.	
Note	that	all	AkAmbient	instances	in	this	mode	and	with
the	same	event	will	have	the	same	trigger	(see	Trigger	On
in	AkEvent).	1AkAmbient
Show	Attenuation	Sphere:	
Shows	a	sphere	that	defines	the	space	where	the	sound
played	by	an	event	can	be	heard.	
For	this	to	work	you	need	to	enable	Max	Attenuation	in
the	SoundBank	settings	in	your	Wwise	project	(Project-
>Project	Settings->Soundbanks->Max	attenuation)

Dont_Show:	
No	attenuation	sphere	is	shown.
Current_Event_Only:	
Shows	the	attenuation	spheres	for	all	the	sounds	that
would	be	played	after	a	call	to
AkSoundEngine.PostEvent	while	in	the	current	mode.
If	in	Simple_Mode,	then	only	the	attenuation	sphere	of
the	sound	coming	from	the	game	object	is	shown.	
if	in	Large_Mode,	then	an	attenuation	sphere	is	shown

https://www.audiokinetic.com/library/?source=SDK&id=_ak_callback_8h_a948c083ff18dc4c8dfe1d32cb0eb6732.html


for	each	point.	
If	in	MultiPosition_Mode,	then	an	attenuation	sphere	is
shown	for	every	other	AkAmbient	in
MultiPosition_Mode	with	the	same	event.
All_Events:	
Shows	the	attenuation	sphere	of	all	AkAmbient
instances	in	the	scene.



Using	Wwise	with	Unity	Timeline
For	Unity's	Timeline	feature,	there	are	custom	Wwise	tracks	for	triggering
Wwise	events	and	setting	Wwise	RTPC	values.

:
Wwise	Timeline	Integration



AkEvironmentAkEvironmentPortalInspector
(Reverb	Zones)
WwiseReverb	Zone	 Environment		 Auxiliary	Sends	
Wwise

AkEnvironmentAkEnvironmentColliderTo	add	an
AkEnvironment	to	your	scene:

Using	the	Wwise	Picker.	This	is	the	simplest	way	to	add	an
AkEnvironment.	AuxBusWwise	PickerUnity	ViewerInspector
AkAmbientGame	Object
"Add	Component" 	AkEnvironmentUnity	Game
ObjectInspector
Using	scripts.	You	can	call
AkSoundEngine.SetGameObjectAuxSendValues()	at	any	time	from	a	C#
script.

2
This	is	useful	if	a	game	object	is	standing	between	two	rooms	or	in	a
tunnel	connecting	two	environments.	

To	add	an	environment	portal	to	your	project,	go	to	GameObject-
>Wwise->Environment	Portal	in	Unity's	menu	bar.

AkGameObj
AkEnvironmentPortal	objects	will	automatically	detect	AkEnvironment
objects	that	overlap	it.	Inspector2

Wwise4Those	4	environments	are	selected	as	follows:

The	environments	that	are	connected	to	a	portal	and	that	have	the
highest	priority	are	selected	until	we	reach	4	environments	or	until
there	are	no	more	environments	connected	to	a	portal.
If	we	still	don't	have	4	selected	environments,	we	select	the
environments	that	are	not	connected	to	a	portal	as	follows:

Environments	with	the	highest	priority	will	be	selected	until	we
reach	4	environments	(if	the	Default	and	Exclude	Others	flags



are	not	set).
Default

Exclude	Others

AkEnvironment	component:	
Only	4	environments	can	be	active	at	the	same	time.

Priority:	
Defines	the	priority	of	an	environment.	
A	smaller	number	has	a	higher	priority.	
If	a	game	object	is	inside	more	than	4	environments,	only	the	4
environments	with	the	highest	priority	will	be	active	(if	the
Default	and	Exclude	Others	flags	are	not	set).
Default:	
A	default	environment	will	be	active	only	if	it's	the	only
environment	containing	your	game	object.	
If	your	game	object	is	inside	more	than	one	default	environment,
then	only	the	one	with	the	highest	priority	will	be	active.
Exclude	Others:	
An	environment	with	this	flag	can't	be	overlapped	by	other
environments.	
If	your	game	object	is	inside	an	environment	with	the	Exclude
Others	flag,	then	all	other	environments	will	get	discarded.	
If	your	game	object	is	inside	more	than	one	environment	with
the	Exclude	Others	flag,	only	the	one	with	the	highest	priority
will	be	active.
AuxBus	Name:	
Specifies	the	name	of	the	current	AuxBus.	AuxBusAuxBus
AuxBusAuxBus
AuxBus	Wwise	PickerAuxBus

AkEnvironmentPortal	component:	
You	can	create	an	environment	portal	in	Unity	by	going	to
GameObject->Wwise->Environment	Portal.	
You	can	place	an	environment	portal	between	two	environments	to
combine	their	effects	while	your	game	object	is	inside	the	portal.	

The	closer	the	game	object	is	from	an	environment,	the
more	that	environment	will	contribute	towards	the	final	effect.

Environment	#1:	



The	portal	will	automatically	detect	all	environments	that
intersect	the	portal.		
Environment	#2:	
The	portal	will	automatically	detect	all	environments	that
intersect	the	portal.		
Axis:	
The	axis	is	used	to	find	the	contribution	of	each	environment.	
For	example,	if	the	z	axis	is	chosen,	then	moving	along	the	x
axis	won't	have	any	effect	on	the	contribution	of	each
environment.	Z
Note	that	the	axis	is	in	object	space.	So,	rotating	the	portal
will	also	rotate	the	axis.

:
Integrating	Environments	and	Game-defined	Auxiliary	Sends
AK::SoundEngine::SetGameObjectAuxSendValues

https://www.audiokinetic.com/library/?source=SDK&id=integrating__elements__environments.html
https://www.audiokinetic.com/library/?source=SDK&id=namespace_a_k_1_1_sound_engine_a18f56e8e0e881c4efb9080545efbb233.html


Using	C#	code	to	control	the	sound	engine
Most	Wwise	SDK	functions	are	available	in	Unity	through	the
AkSoundEngine	class.	C++		 AK::SoundEngine		 AK::MusicEngine

SDKAPI 	pg_limitations	WwiseAPI
	 GameObjectID	GameObjectUnityAkGameObj
GameObject

EventBankID

Wwise	APIIDWwiseC# Wwise_IDs.h	
Wwise_IDs.cs	 Assets	>	Wwise	>	Convert	Wwise	SoundBank
IDsPython

Sending	MIDI	to	Wwise.

MIDI	can	be	sent	to	Wwise	by	filling	the	AkMIDIPost	members	of
AkMIDIPostArray	class	and	calling	any	of	the	following	methods:

AkMIDIPostArray.PostOnEvent()

AkSoundEngine.PostMIDIOnEvent()

AK.Wwise.Event.PostMIDI()

The	following	is	a	basic	script	that	sends	MIDI	messages	to	the	sound
engine:

public	class	MyMIDIBehaviour	:	UnityEngine.MonoBehav

iour

{

				public	AK.Wwise.Event	SynthEvent;

				private	void	Start()

				{

								AkMIDIPostArray	MIDIPostArrayBuffer	=	new	Ak

MIDIPostArray(6);

								AkMIDIPost	midiEvent	=	new	AkMIDIPost();



								midiEvent.byType	=	AkMIDIEventTypes.NOTE_ON;

								midiEvent.byChan	=	0;

								midiEvent.byOnOffNote	=	56;

								midiEvent.byVelocity	=	127;

								midiEvent.uOffset	=	0;

								MIDIPostArrayBuffer[0]	=	midiEvent;

								midiEvent.byOnOffNote	=	60;

								MIDIPostArrayBuffer[1]	=	midiEvent;

								midiEvent.byOnOffNote	=	64;

								MIDIPostArrayBuffer[2]	=	midiEvent;

								midiEvent.byType	=	AkMIDIEventTypes.NOTE_OFF

;

								midiEvent.byOnOffNote	=	56;

								midiEvent.byVelocity	=	0;

								midiEvent.uOffset	=	48000	*	8;

								MIDIPostArrayBuffer[3]	=	midiEvent;

								midiEvent.byOnOffNote	=	60;

								MIDIPostArrayBuffer[4]	=	midiEvent;

								midiEvent.byOnOffNote	=	64;

								MIDIPostArrayBuffer[5]	=	midiEvent;

								SynthEvent.PostMIDI(gameObject,	MIDIPostArra

yBuffer);

				}

}

Using	the	Audio	Input	Source	Plug-in	in	Unity.

The	audio	input	source	plug-in	can	be	used	via	C#	scripting.	See	Audio
Input	Source	Plug-in	from	the	Wwise	SDK	documentation.

The	following	is	a	basic	script	that	sends	a	test	tone	to	the	audio	input

https://www.audiokinetic.com/library/edge/?source=SDK&id=referencematerial__audioinput.html


source	plug-in:

public	class	MyAudioInputBehaviour	:	UnityEngine.Mon

oBehaviour

{

				public	AK.Wwise.Event	AudioInputEvent;

				public	uint	SampleRate	=	48000;

				public	uint	NumberOfChannels	=	1;

				public	uint	SampleIndex	=	0;

				public	uint	Frequency	=	880;

				private	bool	IsPlaying	=	true;

				bool	AudioSamplesDelegate(uint	playingID,	uint	c

hannelIndex,	float[]	samples)

				{

								for	(uint	i	=	0;	i	<	samples.Length;	++i)

												samples[i]	=	UnityEngine.Mathf.Sin(Frequ

ency	*	2	*	UnityEngine.Mathf.PI	*	(i	+	SampleIndex)	

/	SampleRate);

								if	(channelIndex	==	NumberOfChannels	-	1)

												SampleIndex	=	(uint)(SampleIndex	+	sampl

es.Length)	%	SampleRate;

								//	Return	false	to	indicate	that	there	is	no

	more	data	to	provide.	This	will	also	stop	the	assoc

iated	event.

								return	IsPlaying;

				}

				void	AudioFormatDelegate(uint	playingID,	AkAudio

Format	audioFormat)

				{

								audioFormat.channelConfig.uNumChannels	=	Num

berOfChannels;

								audioFormat.uSampleRate	=	SampleRate;

				}



				private	void	Start()

				{

								AkAudioInputManager.PostAudioInputEvent(Audi

oInputEvent,	gameObject,	AudioSamplesDelegate,	Audio

FormatDelegate);

				}

				//	This	method	can	be	called	by	other	scripts	to

	stop	the	callback

				public	void	StopSound()

				{

								IsPlaying	=	false;

				}

				private	void	OnDestroy()

				{

								AudioInputEvent.Stop(gameObject);

				}

}

Apply	Custom	Positioning	in	Unity

By	default,	the	AkGameObj	component	is	attached	to	a	specific	Unity
gameObject	and	uses	its	transform	(with	an	optional	offset)	for	full
positioning.	This	is	usually	adequate	for	many	games,	such	as	first-
person	shooters.	However,	games	with	custom	camera	angles,	such	as
many	third-person	games,	may	find	it	difficult	to	accommodate	the	two
aspects	of	positioning	(distance	attenuation	and	spatialization)	by	simply
attaching	the	audio	listener	to	one	game	object,	such	as	the	main	camera
in	Unity.	Other	games	may	want	players	to	experience	other	custom
positioning.

To	this	end,	the	AkGameObj	component	class	provides	overridable
positioning	to	Unity	users.	Through	the	three	virtual	methods
GetPosition(),	GetForward(),	and	GetUpward(),	users	can	derive	a
subclass	from	AkGameObj	and	use	that	subclass	component	to	customize
any	number	of	Unity	gameObjects'	positioning.



Here	is	a	simple	example	of	how	to	use	a	custom	component	to	override
the	default	AkAudioListener	behavior.	With	a	third-person	project
integrated	with	Wwise,	remove	the	existing	AkAudioListener	and	its
associated	AkGameObj.	Then	attach	the	following	script	to	the	MainCamera
object,	attach	AkAudioListener,	and	finally	specify	the	target	Unity
gameObject	(such	as	the	player	avatar)	that	the	audio	listener's	position
will	follow.	After	this,	the	distance	attenuation	of	all	the	emitters	will	rely
on	the	selected	target	Unity	gameObject's	position	as	the	listener	position
(an	on-screen	distance	listener),	while	the	orientation	of	all	the	emitters	is
still	based	on	the	main	camera	orientation	as	the	listener	orientation	(an
off-screen	orientation	listener).

#if	!(UNITY_DASHBOARD_WIDGET	||	UNITY_WEBPLAYER	||	U

NITY_WII	||	UNITY_WIIU	||	UNITY_NACL	||	UNITY_FLASH	

||	UNITY_BLACKBERRY)	//	Disable	under	unsupported	pl

atforms.

//

//	Copyright	(c)	2017	Audiokinetic	Inc.	/	All	Rights

	Reserved

//

using	UnityEngine;

using	System;

using	System.Collections.Generic;

[AddComponentMenu	("Wwise/AkGameObj3rdPersonCam")]

[ExecuteInEditMode]	//ExecuteInEditMode	necessary	to

	maintain	proper	state	of	isStaticObject.

public	class	AkGameObj3rdPersonCam	:	AkGameObj

{

				public	Transform	target;												//	The	posit

ion	that	this	camera	will	be	following.	User	can	spe

cify	this	to	the	player	character's	Unity	gameObject

	in	the	Inspector.



				

				//	Sets	the	camera	position	to	the	player's	posi

tion	to	handle	distance	attenuation.

				public	override	Vector3	GetPosition	()

				{

								return	target.GetComponent<AkGameObj>	().Get

Position	();

				}

}

#endif	//	#if	!(UNITY_DASHBOARD_WIDGET	||	UNITY_WEBP

LAYER	||	UNITY_WII	||	UNITY_WIIU	||	UNITY_NACL	||	UN

ITY_FLASH	||	UNITY_BLACKBERRY)	//	Disable	under	unsu

pported	platforms.
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Wwise	Picker
Wwise	PickerWwiseEventSwitchWwise	Picker
Wwise	SettingsMenu	 Edit	>	Wwise	Settings...Wwise
Unity

WwiseWwise	Picker Wwise	Picker
Refresh	ProjectWwiseSoundBankXML

Wwise	PickerWwise	Picker	

+-



SoundBank
SoundBank Generate	SoundBanksSoundBankWwise
PickerSoundBankWwiseUnity:	
WwiseUnity:	SoundBanks	generation	successfulWwiseUnity:	SoundBanks

generation	has	warning(s)	 WwiseUnity:	SoundBanks	generation

error ConsoleSoundBank

Note:	Wwise	SettingsWwise	Windows	Installation	Path	Mac
Wwise	ApplicationUnity Generate	SoundBanksWwiseUnity



Wwise	Picker	
Wwise	PickerGame	ObjectInspector
:

Event AkAmbient
SoundBank AkBank.
Switch	Value AkSwitch
State	Value AkState
Aux	Bus AkEnvironment
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Wwise	Types
Wwise	TypesWwiseSoundBanksEvents
StatesSwitchesWwise	TypesEvent

Wwise	Types:

public	class	WwiseTypesExample	:	UnityEngine.MonoBeh

aviour

{

				public	AK.Wwise.Bank	MyBank	=	null;

				public	AK.Wwise.Event	MyEvent	=	null;

				public	AK.Wwise.RTPC	MyRTPC	=	null;

				public	void	Awake()

				{

								MyBank.Load();

				}

				public	void	Start()

				{

								MyEvent.Post(gameObject);

				}

				private	float	CalculateMyValue()

				{

								return	(float)System.Math.Sin(System.Math.PI

	*	UnityEngine.Time.timeSinceLevelLoad);

				}

				public	void	Update()

				{

								MyRTPC.SetValue(gameObject,	CalculateMyValue

());

				}



}

inspector:

WwiseTypesExamplemarker	callbacks

public	AK.Wwise.CallbackFlags	MyCallbackFlags	=	null

;

public	void	Start()

{

				MyEvent.Post(gameObject,	MyCallbackFlags,	EventC

allback);

}

private	void	EventCallback(object	cookie,	AkCallback

Type	type,	AkCallbackInfo	info)

{

				if	(type	==	AkCallbackType.AK_Marker)

				{

								var	markerInfo	=	info	as	AkMarkerCallbackInf

o;

								if	(markerInfo	!=	null)

								{

												//	...

								}

				}

}
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Adding	New	Triggers	for	Wwise	Events
In	most	of	Wwise	components	for	Unity,	there	is	a	"Trigger	On"	property
from	which	you	can	select	which	Unity	notification/event	will	trigger	the
Wwise	component	(Event,	Switch,	State,	etc).	Unity
Integration

AkTriggerBaseC#AkTriggerBase"Trigger	On"
triggerDelegate(GameObject	in_target)"target"

ColliderWwiseColliderPost

	 GetComponent<YourTriggerClass>

().triggerDelegate(GameObject	in_target)	

Note:	Currently	the	maximum	number	of	derivative	classes	of
AkTriggerBase	is	32.

Here	is	an	example,	with	a	custom	function:

public	class	TriggerOnGunHit	:	AkTriggerBase

{

				void	Hit()

				{

								if(triggerDelegate	!=	null)	

								{

												triggerDelegate(null);

								}

				}

}

From	your	game	code,	you	could	have	this	code:

if	(playerIsShot)

{

				GetComponent<TriggerOnGunHit>().Hit();

}



TriggerOnGunHitWwiseNote	that	in	many	simple	situations,
this	is	completely	superfluous;	you	could	also	simply	call	the	base	Wwise
SDK	through	AkSoundEngine.PostEvent("GunHit",	gameObject)	and	let	the
sound	designer	handle	the	effect	of	this	event	in	Wwise.
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Wwise	Timeline	Integration
Timeline	is	Unity's	cinematic	editting	tool.	It	can	be	used	to	create	game-
play	sequences,	audio	sequences,	and	other	cinematic	content.

For	more	information	on	Timeline	refer	to	Timeline	Docs.

For	instructions	on	how	to	create	a	Timeline	Asset	and	Timeline	instance,
refer	to	Timeline	Usage.

https://docs.unity3d.com/Manual/TimelineOverview.html
https://docs.unity3d.com/Manual/TimelineWorkflowCreatingAssetInstance.html


Wwise	Timeline	Tracks
Wwise	Unity	Integration AkRTPC		 AkEvent	2	 AkRTPC
TrackGame	Parameter	 AkEvent	TrackWwise	Event
tracks	and	AkEvent	tracks	can	be	added	to	a	Timeline	in	Unity	using	the
"Add"	dropdown	button.

Adding	AK	tracks	to	Timeline

Ak	Track	Object	Bindings

AkEvent	tracks	and	AkRTPC	tracks	have	object	bindings	which	can	be
set	to	any	Game	Object.	If	this	is	left	as	None,	the	Event	messages	or
RTPC	messages	in	the	track	will	be	triggered	on	the	Game	Object	that
owns	the	Timeline	(this	is	the	Game	Object	that	has	a	PlayableDirector
component,	which	is	used	to	trigger	the	Timeline).	If	the	track	binding	is
set	to	a	different	Game	Object,	the	messages	will	be	triggered	on	that
Game	Object.

The	AkRTPC	Parameter	Property

AkRTPC	tracks	have	one	property	in	their	property	inspector:
Parameter.	This	is	the	Wwise	RTPC	parameter	that	will	be	set	from	the
various	clips	in	the	track.



RTPC	Track	Parameter	Property

Wwise	Timeline	Playable	Clips

The	AkEvent	track	and	the	AkRTPC	tracks	each	hold	corresponding
clips:	the	AkEventPlayable	clip	and	the	AkRTPCPlayable	clip.	These
can	be	added	to	a	track	using	the	track's	menu.

Adding	AK	clips	to	AK	tracks

Timeline	Clip	Properties

All	clips	in	Timeline	have	timing	properties	that	are	displayed	in	the	top
portion	of	the	inspector.	For	more	information	on	these	properties,	refer	to
Clip	Properties.

AkRTPCPlayable	Clip	Properties

The	following	properties	are	accessible	from	the	inspector	of	an
AkRTPCPlayable	clip:

https://docs.unity3d.com/Manual/script-EditorClip.html


AkRTPCPlayable	Clip	Properties

Set	RTPC	Globally:	If	this	is	checked,	the	RTPC	will	be	set	globally
for	all	objects.
Override	Track	Object:	If	this	is	checked,	the	RTPC	will	be	set	for
the	selected	Game	Object	in	the	RTPC	Object	property	(only
available	when	Set	RTPC	Globally	is	unchecked).
RTPC	Object:	The	Game	Object	for	which	the	RTPC	will	be
updated.	If	this	is	set	to	None,	the	RTPC	will	be	set	on	the	track
object	(or	the	Timeline's	owner	object	if	the	track	object	is	set	to
None).	This	is	only	available	when	Override	Track	Object	is
checked.
Animated	Value:	RTPC	Value:	This	is	the	value	that	will	be
animated	by	the	RTPC	track.	In	order	to	begin	animating	this	value
you	need	to	arm	the	track	for	recording,	set	the	playhead	to
somewhere	within	the	RTPCPlayable	clip,	and	then	edit	the	value
from	the	property	inspector.



Animating	RTPC	Values	from	Timeline

Following	these	steps	will	insert	a	keyframe	into	the	RTPC	track,	below
the	RTPC	clip.	You	can	then	use	this	Unity	curve	editor	to	add	more
keyframes.	The	keyframes	have	a	context	menu	that	can	be	used	for
more	precise	values.



RTPC	Keyframe	Context	Menu

Editting	RTPC	Keyframe	Values

AkEventPlayable	Clip	Properties

The	following	properties	are	accessible	from	the	inspector	of	an
AkEventPlayable	clip:

AkEventPlayable	Clip	Properties

Override	Track	Object:	This	can	be	checked	in	order	to	have	the
Event	emitted	from	a	specific	Game	Object,	different	to	the	track
binding	object.	This	will	also	override	the	Timeline	owner	object	if	the
track	binding	is	set	to	None	(see	Ak	Track	Object	Bindings).
Emitter	Object	Ref:	The	Game	Object	from	which	the	Event	should
be	emitted	(only	available	when	Override	Track	Object	is	checked).
Event:	The	Wwise	Event	that	will	be	triggered	from	this	clip.



Currently	scrubbing	is	only	supported	in	Play	mode	in	the	Unity	editor.
This	is	due	to	an	issue	with	Unity	Playable	callbacks	in	edit	mode.	Unity
are	aware	of	the	issue:	953109.	This	means	that	"Play	from	anywhere"
behavior	is	not	supported	in	edit	mode	either.	If	you	place	the	playhead
somewhere	between	the	beginning	and	end	of	a	clip	and	play	the
timeline,	while	in	edit	mode,	the	event	will	not	be	triggered.

https://fogbugz.unity3d.com/default.asp?953109_kitf7pso0vmjm0m0


Wwise	Project	Setup
	 AkAudioEvent	Tracks	JSONWwise
Project	SettingsSoundBanks Metadata	Options
Estimated	duration SoundBank	Settings Generate
JSON	Metadata



AkEvent
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Build	your	Unity	Game	for	a	Target	Platform
Building	your	Unity	game	for	a	target	platform	is	now	as	simple	as
building	your	application	using	Unity's	standard	pipeline	or	a	build	script.
Pre-	and	post-build	steps	that	generate,	copy	and	delete	SoundBanks
can	be	enabled/disabled	within	the	Edit	>	Wwise	Settings...



Wwise	plug-in	deployment
The	Unity	build	system	automatically	packages	the	Wwise	plug-in	with
the	game.	 Profile	Wwise

PluginsWwise Release

Note:	Debug	is	only	used	for	debugging	specific	issues	with	the
sound	engine,	which	is	usually	done	with	the	assistance	of
Audiokinetic	support.

:

Android
Build	for	iOS
Linux
UnityWwise



StreamingAssets	folder
Unity	normally	creates	a	StreamingAssets	folder	(manually	create	one	if	it
does	not	exist	in	your	Unity	project)	in	the	Unity	project's	Assets	folder,	as
shown	here:	<UNITY_PROJECT_ROOT>\Assets\StreamingAssets.	Unity
Unity StreamingAssets

SoundBank Audio\GeneratedSoundBanks StreamingAssetsUnity

WwisePlatform	Manager
<UNITY_PROJECT_ROOT>\Assets\StreamingAssets\Audio\GeneratedSoundBanks\

<YourPlatform>

Note:	If	necessary,	you	can	modify	AkInitializer::basePath	to
change	the	default	SoundBanks	path.

Unity	EditorSoundBankWwiseProject	SettingsWwise
GeneratedSoundBankWindowsMac

http://unity3d.com/support/documentation/Manual/StreamingAssets.html


Deploying	SoundBanks	in	single-platform
projects
If	you	are	working	on	a	single	platform	title,	instead	of	physically	moving
SoundBank	files	into	the	StreamingAssets	folder,	the	SoundBank	output
path	in	a	Wwise	project	can	be	set	to	the	desired	folder	under	the
StreamingAssets	folder	so	that	the	SoundBanks	can	be	generated
directly	into	the	desired	location.	Using	this	method,	be	sure	to	disable
the	pre-build	steps	related	to	generating	and	copying	SoundBanks	within
the	Wwise	Settings	window.



Deploying	SoundBanks	in	multi-platform
projects
For	productions	that	ship	on	multiple	platforms,	the	pre-build	steps	can
generate	the	SoundBanks	and	copy	them	over	to	the	StreamingAssets
folder	before	the	binary	is	built,	and	then	delete	the	SoundBanks	in	a
post-build	step	to	ensure	that	only	SoundBanks	for	the	target	platforms
are	deployed.

Handling	multiple	custom	platforms	for	a	reference
platform

If,	in	your	Wwise	project,	you	have	defined	multiple	versions	of	the	same
reference	platform,	such	as	an	iPad	and	an	iPhone	platform	targeting
iOS,	some	more	scripting	will	be	needed.	 UnityWwise



Exclude	SoundBank	metadata
Wwise	generates	SoundBank	metadata	files	(such	as	TXTs	and	XMLs).
SoundBank	
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Android
APKAndroidSoundBankLoadBank()	API StreamingAssets

SoundBankUnityAPK AssetsLow-Level 	IOSoundBankAPK

Low-Level	IOAndroidSoundBankSDCard
	 AkSoundEngine.AddBasePath(YourPath)	APK
APKAPKDLC
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Build	for	iOS
UnityiOS BuildBuild	and	RunUnity	EditorUnityXcode
Unity

UNITY_PROJECT_ROOT/Assets/Plugins/iOS

UnityThumbXcodeThumb



Building	for	release
The	Wwise	Integration	library,	libAkSoundEngine.a,	normally	contains	all
debug	symbols.	(iOS)	Player	Settings
Settings Stripping	Level12MB
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Linux
UnityLinuxUnity	Editor BuildBuild	RunUnity
Linux .x8632	bit.x86_6464	bit

Wwise	Unity	Integration	for	Linux	needs	libSDL2	installed	on	the	machine
to	work.	"DLLNotFoundException"

libSDL2	Ubuntu	12.04:

sudo	apt-get	install	build-essential	libasound2-dev

wget	http://www.libsdl.org/release/SDL2-2.0.3.tar.gz

tar	-zxvf	SDL2-2.0.3.tar.gz

cd	SDL2-2.0.3

./configure

make

sudo	make	install

sudo	ldconfig

requirements	may	vary	depending	on	the	machine's	configuration.	
libsdl.org
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UnityWwise
Wwise	Unity	IntegrationWwise
C#

Note:SoundBank GetPlatformName

SoundBank



UNITY_PROJECT_ROOT/Assets/Wwise/Deployment/Components/AkBasePathGetter.cs

GetPlatformName



PS4
iOSiOS3:iPodiPhone
iPad1

1.	 Wwise3Platform	Manager:	"iPod",	"iPhone",
"iPad"WwisePlatform	ManagerWwise Wwise	Help	>
Setting	Up	Your	Projects	>	Managing	Platforms

2.	 Unity AkBasePathGetterC#:
public	partial	class	AkBasePathGetter

{

#if	UNTIY_IOS

				static	partial	void	GetCustomPlatformName(re

f	string	platformName)

				{

								switch(UnityEngine.iOS.Device.generation

)

								{

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch1Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch2Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch3Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch4Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouch5Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPodTouchUnknown:

																platformName	=	"iPod";

																break;

												case	UnityEngine.iOS.DeviceGeneratio

n.iPad1Gen:

												case	UnityEngine.iOS.DeviceGeneratio

https://www.audiokinetic.com/library/?source=Help&id=managing_platforms


n.iPad2Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPad3Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadMini1Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPad4Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadAir1:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadMini2Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadMini3Gen:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadAir2:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPadUnknown:

																platformName	=	"iPad";

																break;

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone3G:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone3GS:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone4:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone4S:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone5:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone5C:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone5S:

												case	UnityEngine.iOS.DeviceGeneratio



n.iPhone6:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhone6Plus:

												case	UnityEngine.iOS.DeviceGeneratio

n.iPhoneUnknown:

												default:

																platformName	=	"iPhone";

																break;

								}

				}

#endif

}

Note:platformName	Unity

3.	 Either,	(a)	create	a	C#	that	extends	AkBuildPreprocessor	or	(b)
create	a	C#	script	that	uses	the	functionality	within
AkBuildPreprocessor.	The	contents	of	the	file	could	be	as	follows:
public	class	WwiseIOSBuildPreprocessor	:	IPrepro

cessBuild,	IPostprocessBuild

{

				public	int	callbackOrder	{	get	{	return	0;	}

	}

				string	iPodDestinationSoundBankFolder	=	stri

ng.Empty;

				string	iPadDestinationSoundBankFolder	=	stri

ng.Empty;

				string	iPhoneDestinationSoundBankFolder	=	st

ring.Empty;

				

				public	void	OnPreprocessBuild(BuildTarget	ta

rget,	string	path)

				{

								if	(target	==	BuildTarget.iOS)

								{

												AkBuildPreprocessor.CopySoundbanks(t

rue,	"iPod",			iPodDestinationSoundBankFolder);



												AkBuildPreprocessor.CopySoundbanks(t

rue,	"iPad",			iPadDestinationSoundBankFolder);

												AkBuildPreprocessor.CopySoundbanks(t

rue,	"iPhone",	iPhoneDestinationSoundBankFolder)

;

								}

				}

				public	void	OnPostprocessBuild(BuildTarget	t

arget,	string	path)

				{

								DeleteSoundbanks(iPodDestinationSoundBan

kFolder);

								DeleteSoundbanks(iPadDestinationSoundBan

kFolder);

								DeleteSoundbanks(iPhoneDestinationSoundB

ankFolder);

				}

}

4.	 Or	in	Wwise,	generate	the	SoundBanks	for	all	three	platforms
"iPhone",	"iPod",	and	"iPad",	and	copy	the	three	resulting	folders	to
UNITY_PROJECT_ROOT/Assets/StreamingAssets/Audio/GeneratedSoundBanks

5.	 UnityiOS
6.	 SoundBank
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WwiseUnityDLC

Wwise

DLCWwiseFile	PackageAuthoring:	 Wwise	>	Help	>
Finishing	Your	Project	>	Managing	File	Packages	>	Downloadable
Content	OverviewBNKWEMDLC
Wwise/UnityLow-Level	IO

UnityAkInitializerBase	Path
AkSoundEngine.LoadFilePackage()	Wwise

Base	PathiOSAndroid

AndroidiOS
AkSoundEngine.LoadFilePackage()		 AkSoundEngine.AddBasePath()	
Operating	System:

#if	UNITY_IPHONE												

				string	fileNameBase	=	Application.dataPath.Subst

ring(0,	Application.dataPath.LastIndexOf('/'));

				fileName	=	fileNameBase.Substring(0,	fileNameBas

e.LastIndexOf('/'))	+	"/Documents/"	+	FILE_NAME;

#elif	UNITY_ANDROID

				fileName	=	Application.persistentDataPath	+	"/"	

+	FILE_NAME	;

#else

				fileName	=	Application.dataPath	+	"/"	+	FILE_NAM

E;

#endif

Androidsdcard

:
OBB	(Android)

https://www.audiokinetic.com/library/?source=Help&id=dlc_overview


Unity	WWW
UnityWWWDLCAkMemBankLoader.cs
Wwise	IO
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Build	the	Native	Integration	Plug-in	from	Source
The	Wwise-Unity	integration	is	a	thin	layer	of	C#	calling	the	native	Wwise
API.	IntegrationC++
C++



The	procedure
1.	 Install	the	Wwise	SDK	for	the	platforms	you	wish	to	build	using	the

Wwise	Launcher.	
2.	 WwiseUnityOSWindowsMacsourcezip

LauncherUnityzipzip_Src.zip
3.	 WindowsMaczip
4.	 Integration	 	
5.	 zip Unity 	
6.	 2:	 Build	using	console	utility		 Integrated

Development	Environment	(IDE) .
7.	 Deployment	API



Notes
During	the	build,	you	can	monitor	warnings,	errors,	or	critical
messages,	if	any,	by	reading	the	detailed	log	messages	found	in	the
Build	Log.



Integration:

All
platforms

Unity	5	PersonalPro
Wwise	SDK	 	
SDK	Wwise	SDK
>	Platform	Requirements
Python	2.7.x3.xPhthon

Android

Cygwin	(Windows)
Android	SDK:	32bitAPI964bitAPI21
Android	NDK	r10e.
Apache	Ant	1.8.4.
Wwise	SDK
Unity
:

CYGWIN_HOME	CygwinWindows
ANDROID_HOME	Android	SDK
ANDROID_NDK_ROOT	Android	NDK
ANT_HOME	Apache	Ant

iOS Xcode	7.2
iOSWwise	SDK	 WWISESDK	

Linux
Build-essential	(sudo	apt-get	install	build-essential)
SDL2	(SDL2 Linux)
LinuxWwise	SDK WWISESDK

Mac
Xcode	7.2
The	Wwise	SDK	for	Mac,	and	a	WWISESDK	environment
variable	pointing	to	it



PS4 Visual	Studio	2012	Professional	Edition.
Windows Visual	Studio	2013	Professional	Edition.
Windows
Store Visual	Studio	2015.

Xbox
One Visual	Studio	2012	Professional	Edition.



How	to	install	the	source	package
Unzip	the	source	package.	Wwise	SDK
IntegrationWwiseUnityAssets
IntegrationAssets



StreamingAssets:	SoundBankDeploying	SoundBanks	in	single-
platform	projects	
Wwise:	

Deployment:	Integration
API:	C++		C#	Wwise	SDK
Dependencies:	Unity
Components:	Unity
Plug-ins:	Unity

Platform
Architecture:	Files	shared	by	architectures	of	a
multi-architecture	platform.

Debug:		 Debug	 Wwise	plug-in
deployment	for	detail	
Profile:		 Profile	 Wwise	plug-in
deployment	for	detail	
Release:		 Release	 Wwise	plug-
in	deployment	for	detail	
DSP:	Wwise

Documentation:	Integration
Editor:	WwiseUnityIntegrationEditor	WindowInspector
Tools:	



Wwise:	
AkSoundEngine:	IntegrationIDC

Common:	
Platform:	IDE

Integration/Assets/Wwise/Deployment:	Integration

API:	API
Generated:	SWIGAPI
Handwritten:	API

Components:	Unity
Plugins:	WwiseAkSoundEngine

<platform>:	
<architecture>:	



Build	using	console	utility
You	can	build	the	Integration	from	the	command	line	using	the	build	script
located	at	Wwise\AkSoundEngine\Common\BuildWwiseUnityIntegration.py.
To	see	the	usage	and	examples,	assuming	your	current
working	directory	is	the	parent	folder	of	the	script,	type	in	a	command
console	on	your	computer:

python	BuildWwiseUnityIntegration.py	-h



Integrated	Development	Environment	(IDE)
Located	in	the	Wwise	Unity	Integration	source	package	under:

WwiseUnityIntegration_version_platform_Src.zip\Wwise

\AkSoundEngine\YourPlatform

the	solution	(or	Xcode	project)	allows	you	to	build	the	Integration	for	the
target	platform	in	a	supported	IDE.

Building	for	the	Mac	or	iOS	platform	with	Xcode

When	building	the	integration	from	the	command	line,	the	WWISESDK	path
is	provided	to	Xcode	automatically	based	on	the	one	set	in	the
environment	variable	$WWISESDK	or	the	one	provided	to	the	build	script
using	the	-w	option.	Xcode	IDEWWISESDKXcodeMaciOS
	AkSoundEngine{platform}	Build	Settings
User-Defined	 WWISESDK	 WWISESDK	(ex:
/Users/myUser/Wwise/SDK	)

Building	for	the	Linux	platform

A	premake	script	is	included	in	the	integration	source	package	that
generated	the	necessary	makefiles.	To	build	the	Linux	plug-in	from
source,	simply	enter	the	following	commands	into	a	terminal:

cd	<Integration	source	location>/AkSoundEngine/Common

./premake4	--akplatform=Linux	gmake

make	-f	AkSoundEngineLinux.make	config=<config>

<config> debug32,	profile32,	release32,	debug64,	profile64,	
release64 <Integration	source	location>/Deployment/Plugins/Linux



Deploy	the	new	lib
The	resulting	binaries	will	be	found	in	Wwise\Deployment\Plugins\
[Platform].	Assets\WwiseAssets



Under	the	hood
SWIGWwise	SDKAPIUnity
WwiseUnitySWIGAPIWwise	for	Unity
SWIGC++

The	build	process	performs	the	following	task:

1.	 The	Wwise	SDK	libraries	are	wrapped	into	a	single	library	as	the
Unity	plug-in,	a	dynamic	library	(.dll)	on	Windows,	a	loadable	bundle
(.bundle)	on	Mac	OS	X,	a	static	library	(.a)	on	iOS,	or	a	shared
library	(.so)	on	Android.	Deployment

	

:

Build	Log
C++Wwise	Integration	Package

Wwise	Unity	IntegrationMon	Jan	8	10:46:17	2018		 	1.6.3

http://www.doxygen.org/index.html


Wwise	Unity	Integration	»	Build	the	Native	Integration	Plug-in	from
Source



Build	Log
WarningUnity	EditorBuild	LogBuild	LogIntegration
	Build	Log

UNITY_PROJECT_ROOT\Assets\Wwise\Logs\BuildWwiseUnity

Integration.log

Time:	Message	type:	Source	Code	File	name	(Module	na

me):	Line	number:	Message	body

2013-09-26	09:29:56,490:	INFO:	BuildWwiseUnityIntegr

ation.py	(WindowsBuilder):	91:	Building:	Windows	(Wi

n32,	Debug)	...

1Unity	Integration
BuildUtil.CreateLogger()

WwiseUnityIntegration_version_platform_Src.zip\Wwise

\AkSoundEngine\Common\AkSoundEngine\Common\BuildUtil

.py

Python	logging.handlers	module

IDEVisual	Studio IDE
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C++Wwise	Integration	Package

Warning:	

UnityUnity
UnityUnity
WwiseUnity(Warning)

Wwise	IntegrationUnity Wwise	Integration
Package UnityWwise	Integration
LauncherWwise	Integration

Warning:	Wwise	IntegrationWwise

The	upgrade	is	done	in	a	3-step	process.	Wwise
Unity



UnityWwise
Wwise	LauncherUnityWwise



Updating	your	Wwise	project	to	the	new	version
1.	 Launch	the	Wwise	version	that	matches	the	new	Wwise	Integration

version	you	intend	on	using	in	Unity.
2.	 Wwise	Project
3.	 Wwise'Yes'
4.	 Wwise	SoundBankUnityWwiseOnce	completed,

make	sure	to	regenerate	your	Wwise	SoundBanks	to	be	ready	to
carry	on	with	your	work	after	updating	the	Unity	project	to	the	new
Wwise	version.

5.	 SoundBankUnityStreamingAssets



Updating	your	C++	code	modifications
1.	 Install	the	updated	Wwise	SDK	on	your	machine,	for	all	your	desired

platforms.
2.	 UnityUnity	Integration	Source	Codezip
3.	 Extract	all	the	downloaded	Unity	Integration	Source	Code	packages

to	the	same	directory
4.	 Merge	the	modifications	you	have	made	to	the	Unity	Integration

Source	Code	into	the	updated	location
5.	 Compile	the	updated	and	merged	integration	source	code
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API
Wwise	SDKIntegration:

UnloadBank()	2
iOSAPI
AK::SoundEngine::iOS::ListenToAudioSessionInterruption()	
GetGameObjectFromPlayingID()	WindowsGameObject	ID
32bitWindows	32bit64bit
PostEvent()		GameObjectAPIGameObject	 null

PostEvent()	
AK::Monitoring::SetLocalOutput()	
AkCallbackManager.SetMonitoringCallback()	
AK::SoundEngine::SetPosition()	
AkSoundEngine.SetObjectPosition()	
PostEvent()	External	Sources1

AK::SoundEngine::DynamicSequence	APIUnity	API
SWIG	
API	 AkSoundEngine.Open()	API
AkSoundEngine.DynamicSequenceOpen()	
C++Unity	 AkArray::operator[]	
AkPlaylistArray.ItemAtIndex(uint	uiIndex)	SWIGC++

API:
iOSAPI
AkSpeakerVolumeMatrixCallbackInfo

AkSpeakerVolumeMatrixBusCallbackInfo

AkBusCallbackFunc

AK::SoundEngine::RegisterBusVolumeCallback

AK::SoundEngine::RegisterCodec

AK::SoundEngine::RegisterGlobalCallback

AK::SoundEngine::RegisterPlugin

AK::SoundEngine::Query::AkGameObjectsList

AK::SoundEngine::Query::GetActiveGameObjects()

AK::SoundEngine::Query::GameObjDst

AK::SoundEngine::Query::AkRadiusList

AK::SoundEngine::Query::GetMaxRadius(AkRadiusList&



io_RadiusList)

Event
AK::SoundEngine::DynamicDialogue::ResolveDialogueEvent	

:
.
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Android

Android
Background	Mode	(Android)
OBB	(Android)
WwiseUnityDLC



iOS
Build	for	iOS
Audio	Session	Interruptions	(iOS)
WwiseUnityDLC



Linux
Linux



Windows	Store	Apps
Windows	Store	Apps	Specific	Information
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Background	Mode	(Android)
	 AK::SoundEngine::Suspend

AkSoundEngine.WakeupFromSuspend()	AkInitializer
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OBB	(Android)

Overview	of	the	OBB	and	Wwise	IO

AndroidUnity Player	Settings	>	Publishing	Settings	>	Split
Application	Binary,	APK	Expansion	Files.obbZip
SoundBankStreamingAssetsAndroid	SoundBank
SoundBankAPKOBB

OBBAkSoundEngine.SetBasePathOBBOBB
I/OOBBpersistent	CPU

http://developer.android.com/google/play/expansion-files.html


Loading	banks	in	memory
AkMemBankLoader.csSoundBank
:

1.	 SoundBank.
2.	 InspectorSoundBank Bank	Name
3.	 SoundBankInspector Is	Localized	Bank AkInitializer.cs

	SoundBank

2 AkMemBankLoader.LoadNonLocalizedBank()	
AkMemBankLoader LoadLocalizedBank()	SoundBank



SoundBankIOZip
SoundBankIntegration
streamingmanager_lowlevel
11SoundBankSoundBank
SoundBankAPIAPIIntegration
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Audio	Session	Interruptions	(iOS)
The	Unity	Integration	supports	two	audio	session	categories.

AkAudioSessionCategorySoloAmbient	(Default)	
SilentiPhoneRing/Silent

AkAudioSessionCategoryAmbient		AmbientSound	

BGM	(BackGround	Music)
UI
AkCallbackManager.SetBGMCallback()	

SoloAmbientBGMAmbient
BGMBGM

Note:	The	background	and	foreground	switching	is	handled
internally	on	iOS,	no	need	to	call	Suspend	and
WakeupFromSuspend	manually	on	this	platform.
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Windows	Store	Apps	Specific	Information
Universal	Windows	PlatformWindows	SoundBanks2SDK
SoundBank
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Licensing	(Free	&	Commercial)
Wwise	licenses	are	required	for	any	games	that	are	released	publicly.	
1Audiokinetic

Free	Limited	Commercial	License
Educational	&	Non	Commercial	License
Royalty-based	License
Commercial	License
Licensing	FAQ
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Wwise
Wwise	Unity	IntegrationWwise	LauncherUnity"Recent
Unity	Projects"UnityIntegration

3D""



Wwise	Demo	SceneWwise	Launcher Wwise
LauncherUnityWwise

:	

SoundBank

Wwise	Project <DEMO_SCENE_ROOT>/WwiseProjectWwise
AssetsDemo



Wwise	Demo	SceneWwise	Unity	IntegrationUnity	Editor

Wwise	Demo	Scene:

1.	 LauncherUnityWwise	Demo	Scene	Unity Modify	Wwise	in
Project...
1.	 LauncherUnity

2.	 Deployment	Platform Modify
3.	 Unity
4.	 SoundBank
5.	 Generated	SoundBanksStreamingAssets/Audio
6.	 Unity



Footsteps

Wwise	ProjectRandomSwitch Footstep

Footstep_material 	4

Box	Collider Footstep_MaterialSwitch 	ValueWwise	Picker
WindowBox	ColliderFirst	Person	ControllerColliderSwitch
"AkTriggerEnter"Ak	Switch"Use	Other	Object"
Inspector	Window

0.3 FootstepFirst 	Person	ControllerWwise
SoundEngine



Subtitle
Unity

Delegate AkTriggerButtonPressDelegate

AkTriggerBasetriggerDelegate AkTriggerBaseWwise 	Component
Inspector"trigger"Ak	Ambient	

WAVAk	AmbientInspector"Use
Callback"(	 SubtitleDemo.cs	)GameObject	(
Object"Callback	Function	(
Callback	Flags"Marker" SubtitleDemoCallback

MarkerCallback	uIdentifier 	unity_use_AkEvent_AkAmbient



Environment
StationEnvironmentZone21Box	Collider
AuxBusWwise	Picker

Wwise2Auxiliary	BusLittle	Sequence"Use	game-
defined	Auxiliary	sends"

EnvironmentZoneWwiseAuxBus

Environment	Portal23Environment	PortalAuxiliary

Ak	Environemnts2Box	Collider1'z'RedBlue
IAk	Environment	Portal2

EnvironmentEnvironment	PortalAkEvironmentAkEvironmentPortal
Inspector	(Reverb	Zones)



Timeline	Demo
This	station	demonstrates	the	use	of	an	AkEventTrack	and	an
AkRTPCTrack	within	a	Timeline	in	Unity.	There	are	two	cubes,	which,
when	the	button	is	pressed,	are	animated	towards	each	other	and
stopped	when	they	reach	impact.

In	order	to	inspect	the	Timeline,	select	Window->Timeline.	Then	in	the
Hierarchy,	expand	the	TimelineDemo	object,	and	then	expand	the
Timeline	Demo	Button	object.	Then	select	the	Button	object.	The
Timeline	editor	will	now	show	the	Timeline	that	controls	the	animation
and	Wwise	Events	for	the	cubes.	The	Timeline	is	controlled	by	the
Playable	Director	component	of	the	Button	object.

The	Timeline	contains	two	animation	tracks,	one	for	each	cube.	These
tracks	are	used	to	animate	the	z	position	of	each	cube	over	time.	The
Timeline	also	contains	an	AkEventTrack	and	an	AkRTPCTrack,	marked
by	a	white	and	red	tab,	respectively.	The	AkEventTrack	contains	two
AkEventPlayable	clips:	the	first	triggers	the	PlayCubeMovement	Wwise
Event,	and	the	next	triggers	the	PlayImpact	Wwise	Event.	The	names	of
these	Wwise	Events	are	displayed	in	the	clips.	You	may	need	to	increase
the	size	of	the	Timeline	editor	view	and	zoom	in	in	order	for	the	name	to
be	displayed	correctly.	The	PlayCubeMovement	Wwise	Event	plays	a
sine	wave	source,	which	has	an	RTPC	affecting	its	pitch.	The	name	of
this	RTPC	is	CubeAcceleration.	The	AkRTPCTrack	increases	this	RTPC
over	time	as	the	cubes	move	towards	each	other.	This	causes	the	pitch
of	the	sine	wave	to	increase,	producing	a	simple	sound	effect	to	indicate
the	acceleration	of	each	cube	towards	the	other.

For	more	information	on	the	Timeline	integration,	see	Wwise	Timeline
Integration
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Using	UnityWwise	Spatial	Audio
This	chapter	gives	an	overview	of	how	to	use	the	Spatial	Audio	features
of	the	Unity	integration.	It	is	broken	down	into:

A	preparation	page	you	need	to	follow	before	going	to	the	tutorials:
Preparation	for	the	Spatial	Audio	Tutorials

1.	Create	a	Unity	Project
2.	Wwise	Project	Preparation
3.	Unity	Project	Preparation

Two	independent	tutorials:
Surface	Reflectors	Tutorial
Rooms	and	Portals	Tutorial

And	a	supplementary	page	addressing	the	use	of	obstruction	and
occlusion:

Obstruction	and	Occlusion

Note:	Completion	of	sections	using	the	Wwise	Reflect	plug-in	require	the
appropriate	license.
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Preparation	for	the	Spatial	Audio	Tutorials
The	following	steps	must	be	followed	beforehand	to	successfully
complete	the	Surface	Reflectors	Tutorial	and	the	Rooms	and	Portals
Tutorial	:

1.	Create	a	Unity	Project
2.	Wwise	Project	Preparation
3.	Unity	Project	Preparation

3.A.	Environment
3.B.	Character	Listener
3.C.	Third-Person	Emitters
3.D.	Scene



1.	Create	a	Unity	Project
WwiseUnity

1.	 Launch	Unity	and	create	a	new	project.
2.	 Unity
3.	 Start	the	Wwise	Launcher	and	integrate	Wwise	into	your	Unity

project.

https://www.audiokinetic.com/library/edge/?source=InstallGuide&id=integrating_wwise_into_an_unreal_or_unity_project


2.	Wwise	Project	Preparation
For	the	tutorials,	you	will	need	a	Sound	SFX,	an	Event	to	play	it,	and	a
SoundBank.

1.	 From	the	Launcher,	open	your	project	in	Wwise.
2.	 Add	a	Sound	SFX	under	the	Actor	Mixer	Hierarchy's	Default	Work

Unit.	In	the	integration	Wwise	Project,	we	added	a	dialogue.
1.	 Import	a	sound	into	it.
2.	 In	the	Sound	Property	Editor's

1.	 General	Settings	tab,	enable	Use	game-defined	auxiliary
sends.	

Sound	Property	Editor	General	Settings	tab

2.	 Positioning	tab,	enable	positioning	and	choose	3D.
Optionally,	add	an	Attenuation.	



Sound	Property	Editor	Positioning	tab

3.	 Right-click	on	the	Sound	SFX	within	the	Actor-Mixer	Hierarchy,	then
select	New	Event	>	Play.	

Event	Editor

4.	 Go	to	the	SoundBank	layout	(shortcut	F7)	and	add	a	new
SoundBank.	Drag	the	Event	into	the	new	SoundBank.	Here's	how
the	SoundBank	Manager	should	look	in	the	integration	Wwise
Project:	



SoundBank	Manager	and	Editor

5.	 Save	your	project.



3.	Unity	Project	Preparation
In	this	section	we	will	create	our	game	area	and	the	objects	in	it.	We	will
need	a	listener,	emitters,	and	two	rooms.	From	the	Launcher,	open	your
project	in	Unity.	Open	the	Wwise	Picker	(Windows	>	Wwise	Picker),
Refresh	Project,	and	Generate	SoundBanks.	

Wwise	Picker

3.A.	Environment

1.	 Create	a	floor,	walls,	and	ceilings	using	cubes:	GameObject	>	3D
Object	>	Cube.
Object	Name Position Rotation Scale
Floor (0,	0,	0) (0,	0,	0) (50,	0.5,	50)
Wall	Front	Left (-4.5,	3,	-10) (0,	0,	0) (7,	6,	0.5)
Wall	Front	Middle (0,	5,	-10) (0,	0,	0) (2,	2,	0.5)
Wall	Front	Right (2.5,	3,	-10) (0,	0,	0) (3,	6,	0.5)



Wall	Left	Small (-7.75,	3,	-6) (0,	0,	0) (0.5,	6,	8)
Wall	Back	Small (-2,	3,	-2) (0,	0,	0) (12,	6,	0.5)
Ceiling	Small (-2,	5.75,	-6) (0,	0,	0) (12,	0.5,	8)
Wall	Right	Small (3.75,	3,	-8) (0,	0,	0) (0.5,	6,	3.5)
Wall	Front	Large (11.5,	3,	-7.5) (0,	0,	0) (16,	6,	0.5)
Wall	Right	Large (19.25,	3,	3.25) (0,	0,	0) (0.5,	6,	21.5)
Wall	Middle (3.75,	5,	-4.5) (0,	0,	0) (0.5,	2,	3.5)
Wall	Left	Large (3.75,	3,	5.625) (0,	0,	0) (0.5,	6,	16.75)
Wall	Back	Large (11.5,	3,	14) (0,	0,	0) (16,	6,	0.5)
Ceiling	Large (11.5,	5.75,	3.25) (0,	0,	0) (16,	0.5,	22)
Barrier (-4.5,	3,	-17) (0,	0,	0) (7,	6,	0.5)

2.	 Add	spotlights	inside	rooms	(	GameObject	>	Light	>	Spotlight	).
Object	Name Position Rotation Scale
Spotlight	Small	Room (-3,	5.75,	-6) (0,	0,	0) (1,	1,	1)
Spotlight	Large	Room (11.5,	5.75,	5) (0,	0,	0) (1,	1,	1)
1.	 In	the	Light	component,	change:

1.	 Range	to	30.
2.	 Spot	Angle	to	179.

3.B.	Character	Listener

1.	 Create	a	character	with	the	method	of	your	choice.
Object	Name Position Rotation Scale
MainCharacter (0,	1.3,	-20) (0,	0,	0) (1,	1,	1)
1.	 Remove	any	Unity	Audio	Source.
2.	 Add	an	Ak	Audio	Listener	component	to	the	camera.	

Ak	Audio	Listener	component

3.	 Add	an	Ak	Spatial	Audio	Listener	component	to	the	camera.	



Ak	Spatial	Audio	Listener	component

3.C.	Third-Person	Emitters

1.	 Create	buttons	using	cylinders	(	GameObject	>	3D	Object	>
Cylinder	).
Object	Name Position Rotation Scale
Button	Outside (-3,	0.75,	-15) (0,	0,	0) (0.15,	0.5,	0.15)
Button	Small	Room (-3,	0.75,	-5) (0,	0,	0) (0.15,	0.5,	0.15)
Button	Large	Room (7.5,	0.75,	5) (0,	0,	0) (0.15,	0.5,	0.15)

2.	 Add	an	Ak	Spatial	Audio	Emitter	component.

Ak	Spatial	Audio	Emitter	component

3.	 In	the	Ak	Game	Obj	component:
1.	 Enable	the	Environment	Aware	option.
2.	 Enable	the	Use	Default	Listener	option.



Ak	Game	Obj	component

4.	 Add	an	Ak	Ambient	component:
1.	 Choose	your	preferred	way	to	start	the	sound	in	Trigger	On.
2.	 Choose	the	Play_sound	Event	in	Event	Name.

Ak	Ambient	component

5.	 Add	an	Ak	Bank	component:
1.	 Add	the	SoundBank	created	in	2.	Wwise	Project	Preparation

to	Bank	Name.

Ak	Bank	component



6.	 Start	the	game,	connect	it	to	Wwise,	and	open	the	Profiler	layout
(shortcut	F6).

7.	 Play	the	sound	from	a	button.	You	should	hear	the	sound	you
imported	in	the	Wwise	project.

8.	 In	the	Voices	Graph	tab,	you	should	see	the	following	graph.

Button	Outside	Voice	Graph	with	no	Effect

3.D.	Scene

1.	 Save	your	Scene	to	a	convenient	place.
2.	 The	final	look	of	the	scene	is	shown	in	the	following	image.	This

scene	is	available	with	the	Unity	integration	package.	Colors	were
added	to	elements	of	the	scene	for	convenience.	A	mobile	first-
person	controller	was	also	added.



Tutorial	Unity	Scene
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Surface	Reflectors	Tutorial
In	the	following	steps,	this	tutorial	will	show	you	how	to	use	the	new
Reflect	plug-in	with	Spatial	Audio.	You	will	need	a	Reflect	plug-in	license
to	make	the	project	work.

A.	Wwise	Project
B.	Spatial	Audio	Emitter
C.	Surface	Reflector	Component

C.1.	Use	Existing	Meshes
C.2.	Alternative:	Create	a	New	Volume

Note:	This	tutorial	presumes	that	you	have	completed	the	Preparation
for	the	Spatial	Audio	Tutorials.	However,	it	does	not	consider	if	the
Rooms	and	Portals	Tutorial	was	done;	both	tutorials	are	independent.



A.	Wwise	Project
We	need	to	update	our	wwise	project	with	an	Auxiliary	Bus	with	the
Reflect	plug-in	and	Acoustic	Textures.

1.	 Add	an	Auxiliary	Bus	under	the	Master	Audio	Bus.
1.	 In	the	Auxiliary	Bus	Property	Editor,

1.	 Under	the	Effects	tab,	add	the	Wwise	Reflect	effect.

Auxiliary	Bus	Property	Editor	Effects	tab	for	Reflect

2.	 Under	the	Positioning	tab,	enable	positioning	and	choose
2D.



Auxiliary	Bus	Property	Editor	Positioning	tab	for
Reflect

2.	 Import	Reflect	Acoustic	Textures	from:	Project	>	Import	Factory
Assets...
1.	 They	will	be	added	to	the	Virtual	Acoustics	folder	in	the

ShareSets	tab	of	the	Project	Explorer	view.



Factory	Reflect	Acoustic	Textures	in	the	Project	Explorer
ShareSets	tab

2.	 (optional)	You	can	add	custom	Acoustic	Textures	in	the	Virtual
Acoustics	folder	under	Default	Work	Unit.

3.	 Save	your	project.



B.	Spatial	Audio	Emitter
We	need	to	modify	the	spatial	audio	emitter	to	use	our	newly	created
reflect	aux	bus.

1.	 Refresh	your	Wwise	project	in	the	Wwise	Picker:	Windows	>	Wwise
Picker
1.	 Generate	SoundBanks

Wwise	Picker

2.	 Modify	the	Ak	Spatial	Audio	Emitter	component	of	each	button.
1.	 Pick	the	Reflect	Auxiliary	Bus	for	Reflect	Aux	Bus.
2.	 Choose	2	for	the	Reflections	Order.
3.	 Choose	1	for	the	Reflections	Aux	Bus	Gain.
4.	 Choose	100000	for	the	Reflection	Max	Path	Length.
5.	 Check	the	Draw	First	Order	Reflections	and	Draw	Second

Order	Reflections	under	Debug	Draw.



Ak	Spatial	Audio	Emitter	for	Surface	Reflector



C.	Surface	Reflector	Component
You	can	simulate	early	reflections	with	the	Ak	Surface	Reflector
component.	One	way	to	have	surface	reflectors	is	to	use	existing	meshes
of	the	game.	If	the	shape	is	too	complex,	you	may	want	to	add	a	new
object	as	a	surface	reflector.

C.1.	Use	Existing	Meshes

The	advantages	of	using	the	existing	meshes	are	that	you	don't	need	to
create	new	objects	and	each	mesh	can	have	a	different	acoustic	texture.
The	disadvantages	are	that	if	you	have	a	complex	figure,	you	may	send
too	much	triangles	to	the	Spatial	Audio	API	and	this	could	slow	down
your	game.	Also,	another	disadvantage	is	that	each	mesh	only	gets
assigned	one	texture.	In	the	case	of	the	this	tutorial,	this	means	that	it	is
not	possible	to	have	a	different	acoustic	texture	on	the	outside	than	on
the	inside	of	the	rooms.	In	the	scene	provided	by	the	unity	integration,
this	is	the	method	used	for	surface	reflectors.

1.	 Select	all	the	walls,	ceiling	and	floor	from	section	3.A.	Environment
and	add	an	Ak	Surface	Reflector	component.
1.	 In	the	Acoustic	Texture	parameter,	choose	an	acoustic	texture

or	leave	it	at	None	to	have	an	unfiltered	reflection.

Ak	Surface	Reflector	component

2.	
1.	 Since	we	have	enabled	the	drawing	of	reflections	under	Debug

Draw	in	section	,	you	should	see	rays	going	from	the	emitter	to
the	listener	in	the	Scene	window.	(The	ceiling	was	removed	in
the	following	image	to	see	the	rays	clearly)	The	blue	rays	are
first	order	reflections,	i.e.	they	reflect	from	one	surface	before
reaching	the	listener,	and	the	yellow	rays	are	second	order
reflections.	The	name	of	the	triangles	are	displayed	at	the
reflection	point.	A	name	is	made	up	of	the	game	object's	name



and	the	triangle's	number.	A	cube	has	12	triangles,	two	per	face.

Top	view	of	early	reflection	drawings	for	existing	mesh
surface	reflectors

2.	 You	can	see	the	rays	in	the	Game	window	by	enabling	Gizmos;
as	we	can	see	in	the	next	image.	From	this	point	of	view,	we	can
also	see	that	the	Debug	Draw	option	draws	the	triangles	of	the
surfaces	that	are	being	reflected	on.	Leaving	the	ceiling	in	this
view,	we	can	see	that	the	sound	will	also	reflect	from	the	ceiling
on	triangles	7	and	6.



First	person	view	of	early	reflection	drawings	for	existing
mesh	surface	reflectors

3.	 Connect	the	game	in	Wwise	and	go	to	the	Profiler	Layout.	You
should	see	a	similar	graph	when	Button	Small	Room	is	emitting.



Button	Small	Room	Voice	Graph	with	Reflect	Effect

4.	 Double	click	on	the	Auxiliary	Bus	with	the	Reflect	Effect	in	the
graph.	Navigate	to	the	Effects	tab	and	double	click	on	the
Reflect	Effect.	When	playing	the	sound,	you	should	see	the
current	reflections	in	the	graph	and	the	list	of	the	Reflect	Effect
Editor.	In	thw	following	image,	there	is	a	Drywall	acoustic	texture
for	all	the	walls	and	the	ceiling	and	a	Tile	acoustic	texture	for	the
floor.	When	there	are	two	textures	in	the	list,	it	means	that	the
reflection	is	a	second	order	one.

Reflect	Effect	Editor	View

C.2.	Alternative:	Create	a	New	Volume

Creating	a	new	game	object	with	no	mesh	renderer	can	simplify	a
complex	shape.	In	this	optional	section,	we	will	show	you	how	to	have	a
surface	reflector	volume	for	the	interior	of	the	small	room.	You	can	also
mix	solutions	by	having	some	meshes	be	Surface	Reflectors	and	having
an	object	with	no	mesh	renderer	as	well.	For	example.	Having	each
mesh	be	a	surface	reflector	to	have	different	texture	per	wall	inside	of	the



house	and	adding	and	exterior	volume	to	have	a	completly	different
texture	on	the	outside	of	the	house.	It	is	also	possible	to	use	Quads
instead	of	cubes	to	have	a	different	texture	wherever	desired.	But	be
careful	with	intersections	when	using	quads;	you	don't	want	your	sound
to	get	out	of	your	shape.

1.	 Create	a	simpler	unrendered	mesh	using	a	cube:	GameObject	>	3D
Object	>	Cube
Object	Name Position Rotation Scale
Small	Room	Interior (-2,	2.875,	-6) (0,	0,	0) (11,	5.25,	7.5)

1.	 Remove	the	Mesh	Renderer	component
2.	 Check	the	Is	Trigger	in	the	Box	Collider	component
3.	 add	an	Ak	Surface	Reflector.

1.	 Since	we	simplified	the	shape	of	our	room,	the	door	is	now	part	of
the	reflective	surface.	We	don't	have	any	reflections	from	Button
Small	Room	if	we	are	standing	outside.	We	even	get	a	reflection
from	Button	Outside	on	the	door	opening.	You	may	have	noticed	the
name	of	the	reflection	point	is	now	referencing	to	Small	Room
Interior.



Top	view	of	early	reflection	drawings	for	a	new	surface	reflector
volume	when	the	emitter	is	outside

2.	 Entering	the	small	room,	Button	Small	Room's	debug	drawings
appear	and	the	ones	for	Button	Outside	disappear.



Top	view	of	early	reflection	drawings	for	a	new	surface	reflector
volume	when	the	emitter	is	inside
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Rooms	and	Portals	Tutorial
This	tutorial	will	show	you	how	to	use	Rooms	and	Portals	with	Spatial
Audio.	The	following	sections	detail	each	step	in	the	tutorial:

A.	Wwise	Project
B.	Spatial	Audio	Emitter
C.	Rooms
D.	Portals
E.	Portals	and	Reverb
F.	Surface	Reflectors	and	Reverb

Note:	This	tutorial	presumes	that	you	have	completed	the	Preparation
for	the	Spatial	Audio	Tutorials.	However,	it	does	not	consider	if	the
Surface	Reflectors	Tutorial	was	done;	both	tutorials	are	independent.	If
you	did	the	Surface	Reflectors	Tutorial	and	wish	to	continue	with	this
tutorial,	you	can	do	so	without	changing	anything	to	your	scene	except
for	the	optional	step	of	C.2.	Alternative:	Create	a	New	Volume,	which
should	be	reverted.	If	you	wish	to	start	anew,	and	you've	done	the
Surface	Reflectors	Tutorial,	you	can	still	keep	the	same	scene	and	just
remove	any	Ak	Surface	Reflector	components.



A.	Wwise	Project
For	the	rooms	and	portals	tutorial,	we	will	need	to	add	Reverb	Effects
and	modify	Obstruction	curves	to	hear	diffraction	through	a	portal	when
loosing	sight	of	an	emitter.

1.	 Add	two	Auxiliary	Busses	under	the	Master	Audio	Bus	called
SmallRoom	and	LargeRoom.	In	the	Auxiliary	Bus	Property	Editor,
1.	 Under	the	Effects	tab,	add	the	Wwise	RoomVerb	effect.	I	chose

two	different	factory	presets:	Rooms/Room_Medium	for
SmallRoom	and	Cathedrals/Medium	for	LargeRoom.

Auxiliary	Bus	Property	Editor	Effects	tab	for	rooms

2.	 Under	the	Positioning	tab,	enable	positioning	and	choose	3D.



Auxiliary	Bus	Property	Editor	Positioning	tab	for	rooms

2.	 Project	>	Project	Settings	>	Obstruction/Occlusion
1.	 Change	the	curves:

Curve Point	1
X Y

Obstruction	Volume 0 0
Obstruction	LPF 0 0

2.	 Here's	how	the	Obstruction	Volume	curve	looks	like:



Obstruction/Occlusion	curves	in	the	Wwise	Project	Settings

3.	 Save	your	project.



B.	Spatial	Audio	Emitter
We	need	to	modify	the	spatial	audio	emitter	to	use	our	newly	created
reflect	aux	bus.

1.	 Refresh	your	Wwise	project	in	the	Wwise	Picker:	Windows	>	Wwise
Picker
1.	 Generate	SoundBanks

Wwise	Picker

2.	 Modify	the	Ak	Spatial	Audio	Emitter	component	of	each	button.
1.	 Apply	a	gain	of	1	for	the	Room	Reverb	Aux	Bus	Gain

parameter.
2.	 Check	Draw	Sound	Propagation	under	Debug	Draw	and

uncheck	all	the	others.



Ak	Spatial	Audio	Emitter	for	Rooms	and	Portals

3.	 We	will	use	rooms	in	the	next	section,	so	we	need	to	add	a
Rigidbody	component	to	our	emitter;	as	explained	in	the	warning
message	on	the	Ak	Game	Obj	component.
1.	 Click	on	Add	Rigidbody

Ak	Game	Obj	component



C.	Rooms
Each	of	the	rooms	will	have	their	own	room	reverb.	To	do	so,	we	will	use
the	Ak	Room	component.

1.	 Create	unrendered	meshes	using	cubes:	GameObject	>	3D	Object	>
Cube

Object	Name Position Rotation
Small	Room	Interior (-2,	2.875,	-6) (0,	0,	0)
Large	Room	Interior (11.5,	2.875,	3.25) (0,	0,	0)
1.	 Remove	the	Mesh	Renderer	component.
2.	 Check	the	Is	Trigger	in	the	Box	Collider	component.
3.	 Add	an	Ak	Room	component	to	the	Small	and	Large	Room

Interior	Volumes.
1.	 Pick	the	corresponding	SmallRoom	or	LargeRoom	Auxiliary

Busses	for	Reverb	Aux	Bus.
2.	 If	you	added	a	Rigidbody	to	your	emitters,	you	don't	need

one	here.	If	not,	click	on	Add	Rigidbody.

Ak	Room	component

2.	 Start	the	game,	connect	to	Wwise	and	go	to	the	Game	Object
Profiler	layout
1.	 Watch	all	the	emitters	and	the	listener.
2.	 Open	a	Game	Object	3D	Viewer	view.	You	should	see	each

emitter	in	their	respective	rooms.	The	next	image	is	a	top	view
of	the	scene.	The	listener	and	Button	Outside	are	not	in	a	room,
so	they	are	put	by	default	in	the	"Outdoors"	room.	If	everything
is	in	the	Outdoors	room	instead	of	their	respective	rooms,	it
means	spatial	audio	is	disabled.	You	must	have	forgotten	to	add



an	Ak	Spatial	Audio	Listener	component	to	the	listener.	Follow
step	3.B.

Emitters	in	their	respective	rooms	and	the	Listener
Outdoors

3.	 Move	the	listener	to	a	room	and	see	the	room	name	change
under	your	listener	game	object	in	the	Game	Object	3d	Viewer.
In	the	following	image,	the	listener	is	in	the	large	room.



Emitters	in	their	respective	rooms	and	the	Listener	in	the
Large	Room	Interior

3.	 Press	the	button	in	one	of	the	rooms	to	hear	the	reverb.
1.	 In	the	small	room,	the	voice	graph	should	look	like	this:



Button	Small	Room	Voice	Graph	with	Reverb

2.	 When	a	listener	is	in	a	different	room	than	the	emitter,	the	sound
is	completely	occluded.	You	will	need	to	add	portals	to	hear	the
sound	coming	from	rooms	through	desired	openings.

Note:	To	add	a	reverb	outside,	add	a	Room	around	the	entire	area.	Make
sure	that	the	Room	has	a	lower	priority	than	the	Small	Room	Interior	and
Large	Room	Interior.



D.	Portals
Each	Room	needs	a	Portal	to	be	connected	to	another	area.	We	need
two	Portals:	one	on	the	door	between	the	outside	area	and	the	small
Room	and	one	between	both	Rooms.

1.	 Create	two	Ak	Room	Portal	components:	GameObject	>	Wwise	>
Room	Portal

Object	Name Position Rotation
Outside	Portal (0,	2,	-10) (0,	0,	0)
Inside	Portal (3.75,	2,	-4.5) (0,	90,	0)

2.	 In	the	Ak	Room	Portal	component:
1.	 Open	On	Start.
2.	 Close	On	Nothing.
3.	 Make	sure	that	the	Back	Room	and	Front	Room	display	the	right

Ak	Room	components.	If	not,	refresh	the	inspector	by
deselecting	and	selecting	the	Portal	again.

3.	 This	is	how	the	Inside	Portal	Ak	Room	Portal	component	will	look
like:

Ak	Room	Portal	component

4.	 In	the	Scene	window,	a	Portal	is	represented	with	a	yellow	ribbon
around	it	indicating	its	size	and	the	orientation	in	which	it	should	be
placed.	The	red	line	shows	the	separation	between	front	and	back
areas	of	the	Portal.	The	front	is	in	the	same	direction	as	the	local	z
axis.



Ak	Room	Portal	in	the	Scene	window

5.	 You	should	already	see	the	Draw	Sound	Propagation
drawings	indicating	where	the	sound	will	be	coming	from	through	the
portal.	The	sphere	on	the	left	comes	from	the	small	room	emitter	and
the	one	on	the	right	from	the	large	room	emitter.	You	can	see	the
latter	is	actually	coming	from	the	Portal	connecting	the	small	and
large	Rooms.	The	sound	propagation	is	represented	by	red	and	blue
spheres	that	change	in	size	depending	on	the	wet	and	dry	diffraction
angles	respectively.



Game	window	at	Start

1.	 Wwise
2.	 Play	the	button	outside	and	go	inside	the	small	room.

1.	 You	should	see	the	same	sound	propagation	drawings
coming	from	the	outside	emitter	through	the	portal
connecting	with	the	outside.

Sound	Propagation	drawings	from	Button	Outside
when	the	listener	is	inside	Small	Room	Interior

2.	 Move	in	and	out	of	sight	to	hear	the	diffraction	applied	on
the	sound.	You	will	hear	more	or	less	diffraction	depending



on	the	angle	of	the	listener	vs.	the	portal.	In	the	next	image,
we	are	watching	the	listener	and	Button	Outside.	You	can
see	a	top	view	of	the	scene	in	the	Game	Object	3D	Viewer.
In	dark	red,	we	can	see	the	portals.	The	one	in	the	middle	is
the	Outside	Portal,	the	area	on	top	of	the	Portal	is	the	Small
Room	Interior	and	the	area	on	the	bottom	is	the	outside.
The	Listener	is	in	the	Small	Room	Interior	and	the	playing
emitter	is	Button	Outside.	On	the	image,	you	can	see	the
sound	propagation	in	green	between	the	listener	and	the
emitter.	The	Diffraction	angle	is	103.3.	Also,	you	can	see
the	virtual	position	of	the	Button	Outside	emitter	on	the
right.	That's	where	the	sound	you	hear	will	go	through	the
portal.

Portal	diffraction	angle	on	Game	Object	3D	Viewer



E.	Portals	and	Reverb
Sound	emitted	through	Portals	can	also	use	the	reverb	from	the	current
Room	the	listener	is	in.

1.	 Open	the	SmallRoom	Auxiliary	Bus	Property	Editor	and	check	Use
game-defined	auxiliary	sends	in	the	General	Settings	tab.	This	will
send	the	small	Room	reverb	to	other	reverbs	in	the	scene.

Auxiliary	Bus	Property	Editor	General	Settings	tab	to	send
room	reverb	to	other	reverbs

2.	 When	playing	the	small	room	emitter,	and	going	into	the	large	room,
you	will	see	the	small	room's	reverb	feeding	into	the	large	room's
reverb.



Button	Small	Room	reverb	sending	to	Large	Room	Interior
room's	reverb	on	the	Voices	Graph



F.	Surface	Reflectors	and	Reverb
It	is	also	possible	to	feed	early	reflections	into	the	reverb	of	a	Room.	Let's
add	surface	reflectors	in	our	scene.

1.	 Following	section	Surface	Reflectors	Tutorial,
1.	 Add	an	Auxiliary	Bus	with	the	Reflect	Effect.
2.	 Link	each	Ak	Spatial	Audio	Emitter	to	the	new	Reflect

Auxiliary	Bus.
3.	 Add	Ak	Surface	Reflector	components	on	all	the	walls	and	the

floor.
2.	 In	the	Wwise	project,	open	the	Auxiliary	Bus	with	the	Reflect	Effect

applied	to	it.
1.	 In	the	General	Settings	tab,	check	Use	game-defined	auxiliary

sends.

Auxiliary	Bus	Property	Editor	General	Settings	tab	to	send
early	reflection	to	the	room	reverb

3.	 Play	the	scene	and	press	the	button	in	the	small	Room.	With	the



player	in	the	small	Room,	here	is	the	Voices	Graph	we	see:

Early	reflections	in	the	small	room	are	sent	to	the	small	room's
reverb	in	the	Voices	Graph
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Wwise	Unity	Integration	»	Using	UnityWwise	Spatial	Audio



Obstruction	and	Occlusion
It	is	possible	to	obstruct	or	occlude	sounds	in	Unity.	See	the	following
sections	for	details:

A.	Emitter	Obstruction/Occlusion
B.	Portal	Obstruction



A.	Emitter	Obstruction/Occlusion
An	emitter	can	be	obstructed	or	occluded	in	Unity	when	the	Ak	Emitter
Obstruction	Occlusion	component	is	added	to	its	GameObject.	When
your	map	doesn't	use	spatial	audio,	that	is	it	doesn't	have	any	Ak	Room
components,	the	Ak	Emitter	Obstruction	Occlusion	component	will
only	use	occlusion.	In	a	spatial	audio	scene,	this	same	component	will
use	obstruction	with	the	spatial	audio	listener	only;	the	GameObject	with
the	Ak	Spatial	Audio	Listener	component.	Emitter	obstruction	is	applied
to	emitters	that	are	in	the	same	room	as	the	spatial	audio	listener.

1.	 Add	an	Ak	Emitter	Obstruction	Occlusion	component	to	Button
Outside.
1.	 In	Layer	Mask,	select	layers	that	would	block	audio.	In	the

SpatialAudioTutorial	scene	provided	with	the	integration,	we
have	put	the	first	person	character	on	a	user	created	layer
called	"Player".	This	layer	is	not	selected	in	the	Layer	Mask
option.

Ak	Emitter	Obstruction	Occlusion	component



Layer	Mask	options	for	the	Ak	Emitter	Obstruction
Occlusion	component

2.	 Play	the	scene.
1.	 Play	Button	Outside.
2.	 Go	behind	the	Barrier	GameObject	to	hear	it	occluded	or

obstructed	depending	on	the	presence	of	any	GameObjects	with
the	Ak	Room	component	in	your	scene.



B.	Portal	Obstruction
Sound	emitted	through	portals	can	also	be	obstructed.	Use	the	Ak	Room
Portal	Obstruction	component	on	a	game	object	with	an	Ak	Room
Portal	component	to	do	so.	See	section	Rooms	and	Portals	Tutorial	to
add	rooms	and	portals	to	your	scene,	if	not	done	already.

1.	 Add	an	Ak	Room	Portal	Obstruction	component	to	Outside	Portal.
1.	 In	Layer	Mask,	select	layers	that	would	block	audio.	In	the

SpatialAudioTutorial	scene	provided	with	the	integration,	we
have	put	the	rooms	on	a	user	created	layer	called	"Audio
Rooms".	This	layer	is	not	selected	in	the	Layer	Mask	option.

Ak	Room	Portal	Obstruction	component

Layer	Mask	options	for	the	Ak	Room	Portal	Obstruction
component

2.	 Play	the	scene.
1.	 Play	Button	Small	Room.
2.	 Go	behind	the	Barrier	GameObject	to	obstruct	the	portal.



Wwise	Unity	IntegrationMon	Jan	8	10:46:17	2018		 	1.6.3

http://www.doxygen.org/index.html


Wwise	Unity	Integration



UnityDllNotFoundException	console

Wwise	Profiler
Error	during	installation	-	Unity
Wwise	for	MacSoundBank	-	Wwise_IDs.h
Error:	Plugin
MacUnity	Console"Multiple	plugins	with	the	same	name"	
Xbox	One"Failed	to	initialize	the	sound	engine"-in



Wwise2013.2.8
UNITY_PROJECT_ROOT\Assets\Wwise\Deployment\Examples 	Components	

Examples

UnityPackageorms.	



UnityDllNotFoundException	console
WindowsAkSoundEngineDllNotFoundExceptionUnity2

DirectX
Wwise-Unity	IntegrationDebug Microsoft	Visual	Studio
2010	Debug	Redistributables



:

WindowsMacEditorEditor
SoundBankUnityEditorWwiseGenerated
SoundbanksSoundBank1StreamingAssetsWwise
SoundBank
Target	Platform
Sound	EngineScript	Execution	Order	(menu
Edit	>	Project	Settings	>	Script	Execution	Order)AkInitializer
AkTerminator
Unity...
Wwise	ProfilerWwiseF7Capture	Log
Wwise	ProfilerSoundBankProfiling	Settings	(Alt-G)
SoundBankAkBank

Wwise	ProfilerCapture	LogEventSoundBank
AkEvent,	AkAmbient



Wwise	Profiler
Windows

background		 Run	Unity 	(menu	File	>	Build	Settings	>	Player
Settings)
port	24024Wwise
Wwise-Unity	Plug-in	 Debug	
Profile	
Task	Manager"adb.exe"AndroidTCPAndroid
AndroidGoogle

WwiseRemote	Connection Connect	To	IP
IP

port	24024



Error	during	installation	-	Unity
Wwise:	Error	during	installation:	Access	to	the	path	is	deniedUnity
:

Plug-in	( Debug,	Profile,	Release)	 Assets	>	Wwise	>
Install	Plugins	

Unity	IntegrationWwise	Setup
Unity	EditorScene

UnityPlug-in	( Debug,	Profile,	Release)	



Wwise	for	MacSoundBank	-	Wwise_IDs.h
Wwise	for	MacSoundBankWwise_IDs.h:

Wwise	Project
Project	SettingsSoundBanks
Header	file	pathSoundBanks



Error:	Plugin
WwiseAkSoundEngine 	



MacUnity	Console"Multiple	plugins	with	the
same	name"	
Mac		Unity	IntegrationUnity	Console

Multiple	plug-ins	with	the	same	name	'aksoundengine'	(found	at
'Assets/Wwise/Deployment/Plugins/Mac/Release/AkSoundEngine.bundle'
and
'Assets/Wwise/Deployment/Plugins/Mac/Debug/AkSoundEngine.bundle').
Editor11Editor



Xbox	One"Failed	to	initialize	the	sound
engine"-in
Xbox	OneUnityWwiseAssets	>
Project	Settings	>	Audio"Disable	audio"

Unity	5.0.2"Disable	audio"
AkInitializer.cs:

				AkPlatformInitSettings	platformSettings	=	new	Ak

PlatformInitSettings();

				AkSoundEngine.GetDefaultPlatformInitSettings(pla

tformSettings);

				platformSettings.uLEngineDefaultPoolSize	=	(uint

)lowerPoolSize	*	1024;

				platformSettings.fLEngineDefaultPoolRatioThresho

ld	=	memoryCutoffThreshold;

				AkPlatformInitSettings	platformSettings	=	new	Ak

PlatformInitSettings();

				AkSoundEngine.GetDefaultPlatformInitSettings(pla

tformSettings);

				platformSettings.uLEngineDefaultPoolSize	=	(uint

)lowerPoolSize	*	1024;

				platformSettings.fLEngineDefaultPoolRatioThresho

ld	=	memoryCutoffThreshold;

#if	UNITY_XBOXONE	&&	!UNITY_EDITOR

								platformSettings.uMaxXMAVoices	=	0;

#endif

XMA
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UnityIntegration

Unity Scripting	Define	Symbols:

Platform,
Architecture

Custom
Preprocessor

Default
Architecture

Vita,	SW AK_ARCH_VITA_SW Default

Vita,	HW AK_ARCH_VITA_HW NO

Build	Settings	>	Player	Settings...	>	Other	Settings	>
Scripting	Define	Symbols Enter

Note:	
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AK::Wwise::AcousticTexture

AK::Wwise::AuxBus

AK::Wwise::Bank

AK::Wwise::BaseGroupType

AK::Wwise::BaseType

AK::Wwise::CallbackFlags

AK::Wwise::Event

AK::Wwise::RTPC

AK::Wwise::State

AK::Wwise::Switch



AK::Wwise::Trigger

AkAmbient

AkAudioListener



AkBank

AkCallbackManager

AkEmitterObstructionOcclusion

AkEnvironment

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm



AkEnvironmentPortal

AkEvent

AkEventCallbackMsg

AkGameObj



AkInitializer
AkMemBankLoader

AkRoom

AkRoomPortal

AkRoomPortalObstruction

AkSpatialAudioEmitter



AkSpatialAudioListener

AkState

AkSurfaceReflector

AkSwitch

AkTerminator
AkTriggerBase
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AK::Wwise::AcousticTexture



	AK::Wwise::AcousticTexture
This	type	represents	an	Acoustic	Texture.	[]

AK::Wwise::AcousticTexture



This	type	represents	an	Acoustic	Texture.
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AK::Wwise::AuxBus



	AK::Wwise::AuxBus
This	type	represents	an	auxiliary	send	in	the	Master-Mixer	Hierarchy.	[
]

AK::Wwise::AuxBus



This	type	represents	an	auxiliary	send	in	the	Master-Mixer	Hierarchy.

Wwise	Unity	IntegrationMon	Jan	8	10:46:18	2018		 	1.6.3

http://www.doxygen.org/index.html


AK::Wwise::Bank



	AK::Wwise::Bank
This	type	can	be	used	to	load/unload	SoundBanks.	[]

AK::Wwise::Bank



This	type	can	be	used	to	load/unload	SoundBanks.
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AK::Wwise::BaseGroupType



	AK::Wwise::BaseGroupType
This	type	represents	the	base	for	all	Wwise	Types	that	also	require	a
group	GUID,	such	as	State	and	Switch.	[]

AK::Wwise::BaseGroupType



This	type	represents	the	base	for	all	Wwise	Types	that	also	require	a
group	GUID,	such	as	State	and	Switch.
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AK::Wwise::BaseType



	AK::Wwise::BaseType
This	type	represents	the	base	for	all	Wwise	Types	that	require	a	GUID.
[]

AK::Wwise::BaseType



This	type	represents	the	base	for	all	Wwise	Types	that	require	a	GUID.
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AK::Wwise::CallbackFlags



	AK::Wwise::CallbackFlags
This	type	represents	the	values	of	the	flags	used	when	posting	an	Event
with	a	callback.	[]



This	type	represents	the	values	of	the	flags	used	when	posting	an	Event
with	a	callback.
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AK::Wwise::Event



	AK::Wwise::Event
This	type	can	be	used	to	post	Events	to	the	sound	engine.	[]

AK::Wwise::Event



Public	

uint	 Post	(GameObject	gameObject)
	 Posts	this	Event	on	a	GameObject.	

uint	 Post	(GameObject	gameObject,	CallbackFlags	flags,AkCallbackManager.EventCallback	callback,	object	cookie=null)
	 Posts	this	Event	on	a	GameObject.	

uint	 Post	(GameObject	gameObject,	uint	flags,AkCallbackManager.EventCallback	callback,	object	cookie=null)
	 Posts	this	Event	on	a	GameObject.	

void	
ExecuteAction	(GameObject	gameObject,
AkActionOnEventType	actionOnEventType,	int	transitionDuration,
AkCurveInterpolation	curveInterpolation)

	 Executes	various	actions	on	this	event	associated	with	a
GameObject.	

void	 PostMIDI	(GameObject	gameObject,	AkMIDIPostArray	array)
	 Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.	

void	 PostMIDI	(GameObject	gameObject,	AkMIDIPostArray	array,	intcount)
	 Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.	
void	 StopMIDI	(GameObject	gameObject)
	 Stops	MIDI	Events	on	this	Event	associated	with	a	GameObject.
void	 StopMIDI	()
	 Stops	all	MIDI	Events	on	this	Event.	



This	type	can	be	used	to	post	Events	to	the	sound	engine.
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AK::Wwise::RTPC



	AK::Wwise::RTPC
This	type	can	be	used	to	set	game	parameter	values	to	the	sound
engine.	[]

AK::Wwise::RTPC



This	type	can	be	used	to	set	game	parameter	values	to	the	sound
engine.
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AK::Wwise::State



	AK::Wwise::State
This	type	can	be	used	to	set	Wwise	States.	[]

AK::Wwise::State



This	type	can	be	used	to	set	Wwise	States.
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AK::Wwise::Switch



	AK::Wwise::Switch
This	type	can	be	used	to	set	Switch	values	on	gameobjects.	[]

AK::Wwise::Switch



This	type	can	be	used	to	set	Switch	values	on	gameobjects.
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AK::Wwise::Trigger



	AK::Wwise::Trigger
This	type	can	be	used	to	post	triggers	to	the	sound	engine.	[]

AK::Wwise::Trigger



This	type	can	be	used	to	post	triggers	to	the	sound	engine.
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	AkAmbient
Use	this	component	to	attach	a	Wwise	Event	to	any	object	in	a	scene.
The	sound	can	be	started	at	various	moments,	dependent	on	the
selected	Unity	trigger.	This	component	is	more	useful	for	ambient	sounds
(sounds	related	to	scene-bound	objects)	but	could	also	be	used	for	other
purposes.	Since	AkAmbient	has	AkEvent	as	its	base	class,	it	features
the	play/stop,	play	multiple,	stop	multiple	and	stop	all	buttons	for
previewing	the	associated	Wwise	event.	[]

AkAmbient



Public	

int	 eventID	=	0
	 ID	of	the	Event	as	found	in	the	WwiseID.cs	file.	

GameObject	 soundEmitterObject	=	null

	
Game	object	onto	which	the	Event	will	be	posted.
By	default,	when	empty,	it	is	posted	on	the	same
object	on	which	the	component	was	added.	

bool	 enableActionOnEvent	=	false

	

Enables	additional	options	to	reuse	existing
events.	Use	it	to	transform	a	Play	event	into	a	Stop
event	without	having	to	define	one	in	the	Wwise
Project.	

AkActionOnEventType	 actionOnEventType	=AkActionOnEventType.AkActionOnEventType_Stop

	 Replacement	action.	See
AK::SoundEngine::ExecuteEventOnAction().	

AkCurveInterpolation	 curveInterpolation	=AkCurveInterpolation.AkCurveInterpolation_Linear

	 Fade	curve	to	use	with	the	new	Action.	See
AK::SoundEngine::ExecuteEventOnAction().	

float	 transitionDuration	=	0.0f

	 Duration	of	the	fade.	See
AK::SoundEngine::ExecuteEventOnAction().	

const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have
more	than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	

This	property	is	usefull	only	when	used	with
colliders.	When	enabled,	the	target	of	the	action



will	be	the	other	colliding	object.	When	disabled,	it
will	be	the	current	object.	



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



Use	this	component	to	attach	a	Wwise	Event	to	any	object	in	a	scene.
The	sound	can	be	started	at	various	moments,	dependent	on	the
selected	Unity	trigger.	This	component	is	more	useful	for	ambient	sounds
(sounds	related	to	scene-bound	objects)	but	could	also	be	used	for	other
purposes.	Since	AkAmbient	has	AkEvent	as	its	base	class,	it	features
the	play/stop,	play	multiple,	stop	multiple	and	stop	all	buttons	for
previewing	the	associated	Wwise	event.

:
AkAmbientInspector
AkGameObj
AkEvent
Integration	Details	-	Events	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
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	AkAudioListener
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	[]



Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.

:
Integrating	Listeners	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
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	AkBank
Loads	and	unloads	a	SoundBank	at	a	specified	moment.	Vorbis	sounds
can	be	decompressed	at	a	specified	moment	using	the	decode
compressed	data	option.	In	that	case,	the	SoundBank	will	be	prepared.
[]

AkUnityEventHandler



Public	

override	void	 HandleEvent	(GameObject	in_gameObject)
	 Loads	the	SoundBank.	

void	 UnloadBank	(GameObject	in_gameObject)
	 Unloads	a	SoundBank.	



Public	

string	 bankName	=	""
	 Name	of	the	SoundBank,	as	specified	in	the	Wwise	project.

bool	 loadAsynchronous	=	false

	
Check	this	to	load	the	SoundBank	in	the	background.	Be
careful,	if	Events	are	triggered	and	the	SoundBank	hasn't
finished	loading,	you'll	have	"Event	not	found"	errors.	

bool	 decodeBank	=	false
	 Decode	this	SoundBank	upon	load.	

bool	 saveDecodedBank	=	false

	 Save	the	decoded	SoundBank	to	disk	for	faster	loads	in	the
future.	

List<	int	>	 unloadTriggerList	=	new	List<int>(){AkUnityEventHandler.DESTROY_TRIGGER_ID	}
	 Reserved.	
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	
This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current	object.



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



Loads	and	unloads	a	SoundBank	at	a	specified	moment.	Vorbis	sounds
can	be	decompressed	at	a	specified	moment	using	the	decode
compressed	data	option.	In	that	case,	the	SoundBank	will	be	prepared.
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	AkCallbackManager
This	class	manages	the	callback	queue.	All	callbacks	from	the	native
Wwise	SDK	go	through	this	queue.	The	queue	needs	to	be	driven	by
regular	calls	to	PostCallbacks().	This	is	currently	done	in	AkInitializer.cs,
in	LateUpdate().	[]



Static	Public	

static	void	 SetMonitoringCallback	(AK.Monitor.ErrorLevel	in_Level,MonitoringCallback	in_CB)

	 Call	this	to	set	a	function	to	call	whenever	Wwise	prints	a
message	(warnings	or	errors).	

static	void	 SetBGMCallback	(BGMCallback	in_CB,	object	in_cookie)
static	int	 PostCallbacks	()



This	class	manages	the	callback	queue.	All	callbacks	from	the	native
Wwise	SDK	go	through	this	queue.	The	queue	needs	to	be	driven	by
regular	calls	to	PostCallbacks().	This	is	currently	done	in	AkInitializer.cs,
in	LateUpdate().
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	AkEmitterObstructionOcclusion
Obstructs/Occludes	the	emitter	of	the	current	game	object	from	its
listeners	if	at	least	one	object	is	between	them.	[]

AkObstructionOcclusion



Public	

LayerMask	 LayerMask	=	-1
	 Indicates	which	layers	act	as	obstructers/occluders.	

float	 refreshInterval	=	1

	 The	number	of	seconds	between	obstruction/occlusion
checks.	

float	 fadeTime	=	0.5f
	 The	number	of	seconds	for	fade	ins	and	fade	outs.	

float	 maxDistance	=	-1.0f

	
The	maximum	distance	at	which	to	perform
obstruction/occlusion.	A	negative	value	will	be	interpreted
as	inifinite	distance.	



Obstructs/Occludes	the	emitter	of	the	current	game	object	from	its
listeners	if	at	least	one	object	is	between	them.

The	current	implementation	does	not	support	occlusion.
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	AkEnvironment
Use	this	component	to	define	a	reverb	zone.	This	needs	to	be	added	to	a
collider	object	to	work	properly.	AkEvironmentAkEvironmentPortal
Inspector	(Reverb	Zones) .	[]



class		 AkEnvironment_CompareBySelectionAlgorithm



Use	this	component	to	define	a	reverb	zone.	This	needs	to	be	added	to	a
collider	object	to	work	properly.	AkEvironmentAkEvironmentPortal
Inspector	(Reverb	Zones) .

This	component	can	be	attached	to	any	collider.	You	can	specify	a	roll-off
to	fade-in/out	of	the	reverb.	The	reverb	parameters	will	be	defined	in	the
Wwise	project,	by	the	sound	designer.	All	AkGameObj	that	are
"environment"-aware	will	receive	a	send	value	when	entering	the
attached	collider.

:
AkEvironmentAkEvironmentPortalInspector	(Reverb
Zones)
Integrating	Environments	and	Game-defined	Auxiliary	Sends
(Note:	This	is	described	in	the	Wwise	SDK	documentation.)
AK::SoundEngine::SetGameObjectAuxSendValues	(Note:	This
is	described	in	the	Wwise	SDK	documentation.)
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AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm



AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
AkEnvironment::AkEnvironment_CompareByPriority



The	selection	algorithm	is	as	follow:

1.	 Environments	have	priorities.
2.	 Environments	have	a	"Default"	flag.	This	flag	effectively	says	that

this	environment	will	be	bumped	out	if	any	other	is	present.
3.	 Environments	have	an	"Exclude	Other"	flag.	This	flag	will	tell	that	this

env	is	not	overlappable	with	others.	So,	only	one	(the	highest
priority)	should	be	selected.
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	AkEnvironmentPortal
Use	this	component	to	define	an	area	that	straddles	two	different
AkEnvironments	zones	and	allow	mixing	between	both	zones.
AkEvironmentAkEvironmentPortalInspector	(Reverb	Zones) .	[]



Public	

float	 GetAuxSendValueForPosition	(Vector3	in_position,	int	index)
	 The	axis	used	to	find	the	contribution	of	each	environment.	



Public	

Vector3	 axis	=	new	Vector3(1,0,0)



Use	this	component	to	define	an	area	that	straddles	two	different
AkEnvironments	zones	and	allow	mixing	between	both	zones.
AkEvironmentAkEvironmentPortalInspector	(Reverb	Zones) .
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	AkEvent
Helper	class	that	knows	a	Wwise	Event	and	when	to	trigger	it	in	Unity.	As
of	2017.2.0,	the	AkEvent	inspector	has	buttons	for	play/stop,	play
multiple,	stop	multiple,	and	stop	all.	Play/Stop	will	play	or	stop	the	event
such	that	it	can	be	previewed	both	in	edit	mode	and	play	mode.	When
multiple	objects	are	selected,	Play	Multiple	and	Stop	Multiple	will	play	or
stop	the	associated	AkEvent	for	each	object.	[]

AkEvent



Public	

int	 eventID	=	0
	 ID	of	the	Event	as	found	in	the	WwiseID.cs	file.	

GameObject	 soundEmitterObject	=	null

	
Game	object	onto	which	the	Event	will	be	posted.
By	default,	when	empty,	it	is	posted	on	the	same
object	on	which	the	component	was	added.	

bool	 enableActionOnEvent	=	false

	

Enables	additional	options	to	reuse	existing
events.	Use	it	to	transform	a	Play	event	into	a	Stop
event	without	having	to	define	one	in	the	Wwise
Project.	

AkActionOnEventType	 actionOnEventType	=AkActionOnEventType.AkActionOnEventType_Stop

	 Replacement	action.	See
AK::SoundEngine::ExecuteEventOnAction().	

AkCurveInterpolation	 curveInterpolation	=AkCurveInterpolation.AkCurveInterpolation_Linear

	 Fade	curve	to	use	with	the	new	Action.	See
AK::SoundEngine::ExecuteEventOnAction().	

float	 transitionDuration	=	0.0f

	 Duration	of	the	fade.	See
AK::SoundEngine::ExecuteEventOnAction().	

const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have
more	than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	

This	property	is	usefull	only	when	used	with
colliders.	When	enabled,	the	target	of	the	action



will	be	the	other	colliding	object.	When	disabled,	it
will	be	the	current	object.	



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



Helper	class	that	knows	a	Wwise	Event	and	when	to	trigger	it	in	Unity.	As
of	2017.2.0,	the	AkEvent	inspector	has	buttons	for	play/stop,	play
multiple,	stop	multiple,	and	stop	all.	Play/Stop	will	play	or	stop	the	event
such	that	it	can	be	previewed	both	in	edit	mode	and	play	mode.	When
multiple	objects	are	selected,	Play	Multiple	and	Stop	Multiple	will	play	or
stop	the	associated	AkEvent	for	each	object.

:
Edit	Mode
AkAmbientInspector
Integration	Details	-	Events	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
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	AkEventCallbackMsg
Event	callback	information.	Event	callback	functions	can	receive	this
structure	as	a	parameter.	[]



Public	

GameObject	 sender

	 AkSoundEngine.PostEvent	callback	flags.	See	the
AkCallbackType	enumeration	for	a	list	of	all	callbacks.

AkCallbackInfo	 info

	 GameObject	from	whom	the	callback	function	was
called.	



Event	callback	information.	Event	callback	functions	can	receive	this
structure	as	a	parameter.
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	AkGameObj
This	component	represents	a	sound	object	in	your	scene	tracking	its
position	and	other	game	syncs	such	as	Switches,	RTPC	and
environment	values.	You	can	add	this	to	any	object	that	will	emit	sound,
and	it	will	be	added	to	any	object	that	an	AkAudioListener	is	attached
to.	Note	that	if	it	is	not	present,	Wwise	will	add	it	automatically,	with	the
default	values,	to	any	Unity	Game	Object	that	is	passed	to	Wwise.	[]



Public	

bool	 AddListener	(AkAudioListener	listener)

	 Adds	an	AkAudioListener	to	the	container	of	listeners
listening	to	this	gameobject.	

bool	 RemoveListener	(AkAudioListener	listener)

	 Removes	an	AkAudioListener	from	the	container	of
listeners	listening	to	this	gameobject.	

virtual	Vector3	 GetPosition	()
virtual	Vector3	 GetForward	()
virtual	Vector3	 GetUpward	()



Public	

AkGameObjPositionOffsetData	 m_positionOffsetData	=	null

	
When	not	set	to	null,	the	position	will
be	offset	relative	to	the	Game	Object
position	by	the	Position	Offset.	

bool	 isEnvironmentAware	=	true

	

Is	this	object	affected	by	Environment
changes?	Set	to	false	if	not	affected	in
order	to	save	some	useless	calls.
Default	is	true.	



This	component	represents	a	sound	object	in	your	scene	tracking	its
position	and	other	game	syncs	such	as	Switches,	RTPC	and
environment	values.	You	can	add	this	to	any	object	that	will	emit	sound,
and	it	will	be	added	to	any	object	that	an	AkAudioListener	is	attached
to.	Note	that	if	it	is	not	present,	Wwise	will	add	it	automatically,	with	the
default	values,	to	any	Unity	Game	Object	that	is	passed	to	Wwise.

:
Integration	Details	-	Game	Objects	(Note:	This	is	described	in
the	Wwise	SDK	documentation.)
Integration	Details	-	Events	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
Integrating	Listeners	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
Integration	Details	-	Switches	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
Integration	Details	-	States	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
Integration	Details	-	Environments	and	Game-defined	Auxiliary
Sends	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
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	AkInitializer



Public	

string	 basePath	=	AkSoundEngineController.s_DefaultBasePath

	 Path	for	the	soundbanks.	This	must	contain	one	sub	folder
per	platform,	with	the	same	as	in	the	Wwise	project.	

string	 language	=	AkSoundEngineController.s_Language
	 Language	sub-folder.	

int	 defaultPoolSize	=AkSoundEngineController.s_DefaultPoolSize

	
Default	Pool	size.	This	contains	the	meta	data	for	your	audio
project.	Default	size	is	4	MB,	but	you	should	adjust	for	your
needs.	

int	 lowerPoolSize	=	AkSoundEngineController.s_LowerPoolSize

	
Lower	Pool	size.	This	contains	the	audio	processing	buffers
and	DSP	data.	Default	size	is	2	MB,	but	you	should	adjust
for	your	needs.	

int	 streamingPoolSize	=
AkSoundEngineController.s_StreamingPoolSize

	 Streaming	Pool	size.	This	contains	the	streaming	buffers.
Default	size	is	1	MB,	but	you	should	adjust	for	your	needs.	

int	 preparePoolSize	=AkSoundEngineController.s_PreparePoolSize

	
Prepare	Pool	size.	This	contains	the	banks	loaded	using
PrepareBank	(Banks	decoded	on	load	use	this).	Default	size
is	0	MB,	but	you	should	adjust	for	your	needs.	

float	 memoryCutoffThreshold	=
AkSoundEngineController.s_MemoryCutoffThreshold

	
This	setting	will	trigger	the	killing	of	sounds	when	the
memory	is	reaching	95%	of	capacity.	Lowest	priority	sounds
are	killed.	

int	 monitorPoolSize	=
AkSoundEngineController.s_MonitorPoolSize

	 Monitor	Pool	size.	Size	of	the	monitoring	pool,	in	bytes.	This
parameter	is	not	used	in	Release	build.	



int	 monitorQueuePoolSize	=
AkSoundEngineController.s_MonitorQueuePoolSize

	 Monitor	Queue	Pool	size.	Size	of	the	monitoring	queue	pool,
in	bytes.	This	parameter	is	not	used	in	Release	build.	

int	 callbackManagerBufferSize	=AkSoundEngineController.s_CallbackManagerBufferSize

	
CallbackManager	buffer	size.	The	size	of	the	buffer	used
per-frame	to	transfer	callback	data.	Default	size	is	4	KB,	but
you	should	increase	this,	if	required.	

int	 spatialAudioPoolSize	=AkSoundEngineController.s_SpatialAudioPoolSize

	 Spatial	Audio	Lower	Pool	size.	Default	size	is	4	MB,	but	you
should	adjust	for	your	needs.	

uint	 maxSoundPropagationDepth	=
AkSoundEngine.AK_MAX_SOUND_PROPAGATION_DEPTH

	

Spatial	Audio	Max	Sound	Propagation	Depth.	Maximum
number	of	rooms	that	sound	can	propagate	through;	must	be
less	than	or	equal	to
AK_MAX_SOUND_PROPAGATION_DEPTH.	

AkDiffractionFlags	 diffractionFlags	=	AkDiffractionFlags.DefaultDiffractionFlags

	 Enable	or	disable	specific	diffraction	features.	See
AkDiffractionFlags.	

bool	 engineLogging	=AkSoundEngineController.s_EngineLogging

	 Enable	Wwise	engine	logging.	Option	to	turn	on/off	the
logging	of	the	Wwise	engine.	



This	script	deals	with	initialization,	and	frame	updates	of	the	Wwise	audio
engine.	It	is	marked	as	DontDestroyOnLoad	so	it	stays	active	for	the	life	of
the	game,	not	only	one	scene.	You	can,	and	probably	should,	modify	this
script	to	change	the	initialization	parameters	for	the	sound	engine.	A	few
are	already	exposed	in	the	property	inspector.	It	must	be	present	on	one
Game	Object	at	the	beginning	of	the	game	to	initialize	the	audio	properly.
It	must	be	executed	BEFORE	any	other	MonoBehaviors	that	use
AkSoundEngine.

:
Initialize	the	Different	Modules	of	the	Sound	Engine	(Note:	This
is	described	in	the	Wwise	SDK	documentation.)
AK::SoundEngine::Init()	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
AK::SoundEngine::Term()	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
AkCallbackManager
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	AkMemBankLoader



Public	

void	 LoadNonLocalizedBank	(string	in_bankFilename)
	 Load	a	sound	bank	from	WWW	object.	
void	 LoadLocalizedBank	(string	in_bankFilename)
	 Load	a	language-specific	bank	from	WWW	object.	



Public	

string	 bankName	=	""
	 Name	of	the	bank	to	load.	
bool	 isLocalizedBank	=	false

	 Is	the	bank	localized	(situated	in	the	language	specific	folders).	



This	class	is	an	example	of	how	to	load	banks	in	Wwise,	if	the	bank	data
was	preloaded	in	memory.	This	would	be	useful	for	situations	where	you
use	the	WWW	class
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	AkRoom
An	AkRoom	is	an	enclosed	environment	that	can	only	communicate	to
the	outside/other	rooms	with	AkRoomPortals.	[]



Public	

ulong	 GetID	()
	 Access	the	room's	ID.	



Public	

AK.Wwise.AuxBus	 reverbAuxBus
	 The	reverb	auxiliary	bus.	

float	 reverbLevel	=	1

	 The	reverb	control	value	for	the	send	to	the
reverb	aux	bus.	

float	 wallOcclusion	=	1

	 Occlusion	level	modeling	transmission	through
walls.	

int	 priority	=	0



An	AkRoom	is	an	enclosed	environment	that	can	only	communicate	to
the	outside/other	rooms	with	AkRoomPortals.
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	AkRoomPortal
An	AkRoomPortal	can	connect	two	AkRoom	components	together.	[
]

AkUnityEventHandler



Public	

ulong	 GetID	()
	 Access	the	portal's	ID.	
override	void	 HandleEvent	(GameObject	in_gameObject)
	 Opens	the	portal	on	trigger	event.	

void	 ClosePortal	(GameObject	in_gameObject)
	 Closes	the	portal	on	trigger	event.	



Public	

const	int	 MAX_ROOMS_PER_PORTAL	=	2
	 AkRoomPortals	can	only	connect	a	maximum	of	2	rooms.	
AkRoom[]	 rooms	=	new	AkRoom[MAX_ROOMS_PER_PORTAL]
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	

This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current
object.	



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



An	AkRoomPortal	can	connect	two	AkRoom	components	together.
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	AkRoomPortalObstruction
Obstructs/Occludes	the	spatial	audio	portal	of	the	current	game	object
from	the	spatial	audio	listener	if	at	least	one	object	is	between	them.	[]

AkObstructionOcclusion



Public	

LayerMask	 LayerMask	=	-1
	 Indicates	which	layers	act	as	obstructers/occluders.	

float	 refreshInterval	=	1

	 The	number	of	seconds	between	obstruction/occlusion
checks.	

float	 fadeTime	=	0.5f
	 The	number	of	seconds	for	fade	ins	and	fade	outs.	

float	 maxDistance	=	-1.0f

	
The	maximum	distance	at	which	to	perform
obstruction/occlusion.	A	negative	value	will	be	interpreted
as	inifinite	distance.	



Obstructs/Occludes	the	spatial	audio	portal	of	the	current	game	object
from	the	spatial	audio	listener	if	at	least	one	object	is	between	them.

If	no	spatial	audio	listener	has	been	registered,	there	will	be	no
obstruction.
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	AkSpatialAudioEmitter
Add	this	script	on	the	GameObject	which	represents	an	emitter	that	uses
the	Spatial	Audio	API.	[]

AkSpatialAudioBase



Public	

AK.Wwise.AuxBus	 reflectAuxBus

	 The	Auxiliary	Bus	with	a	Reflect	plug-in	Effect
applied.	

uint	 reflectionsOrder	=	1
float	 reflectionsAuxBusGain	=	1

	 The	gain	[0,	1]	applied	to	the	reflect	auxiliary	bus.
float	 reflectionMaxPathLength	=	1000

	
The	maximum	path	length	a	sound	path	can
have	from	the	emitter	to	the	listener	after
reflecting	on	surfaces.	

float	 roomReverbAuxBusGain	=	1

	
Send	gain	(0.f-1.f)	that	is	applied	when	sending
to	the	aux	bus	associated	with	the	room	that	the
emitter	is	in.	



Add	this	script	on	the	GameObject	which	represents	an	emitter	that	uses
the	Spatial	Audio	API.
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	AkSpatialAudioListener
Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.	[]

AkSpatialAudioBase



Add	this	script	on	the	game	object	that	represent	a	listener.	This	is
normally	added	to	the	Camera	object	or	the	Player	object,	but	can	be
added	to	any	game	object	when	implementing	3D	busses.
isDefaultListener	determines	whether	the	game	object	will	be
considered	a	default	listener	-	a	listener	that	automatically	listens	to	all
game	objects	that	do	not	have	listeners	attached	to	their
AkGameObjListenerList's.

:
Integrating	Listeners	(Note:	This	is	described	in	the	Wwise	SDK
documentation.)
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	AkState
This	will	call	AkSoundEngine.SetState()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.	[]

AkUnityEventHandler



Public	

int	 groupID
	 State	Group	ID,	as	defined	in	WwiseID.cs.	

int	 valueID
	 State	Value	ID,	as	defined	in	WwiseID.cs.	
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	
This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current	object.



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



This	will	call	AkSoundEngine.SetState()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.

:
Integration	Details	-	States	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
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	AkSurfaceReflector
This	component	will	convert	the	triangles	of	the	GameObject's	geometry
into	sound	reflective	surfaces.	[]



Static	Public	

static	void	 AddGeometrySet	(AK.Wwise.AcousticTexture
acousticTexture,	MeshFilter	meshFilter)

	 Sends	the	mesh	filter's	triangles	and	their	acoustic	texture
to	Spatial	Audio.	

static	void	 RemoveGeometrySet	(MeshFilter	meshFilter)

	 Remove	the	corresponding	mesh	filter's	geometry	from
Spatial	Audio.	



Public	

AK.Wwise.AcousticTexture	 AcousticTexture

	

All	triangles	of	the	component's	mesh
will	be	applied	with	this	texture.	The
texture	will	change	the	filter	parameters
of	the	sound	reflected	from	this
component.	



This	component	will	convert	the	triangles	of	the	GameObject's	geometry
into	sound	reflective	surfaces.

This	component	requires	a	Mesh	Filter	component.	The	triangles	of	the
mesh	will	be	sent	to	the	Spatial	Audio	wrapper	by	calling
SpatialAudio::AddGeometrySet().	The	triangles	will	reflect	the	sound
emitted	from	AkSpatialAudioEmitter	components.
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	AkSwitch
This	will	call	AkSoundEngine.SetSwitch()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.	[]

AkUnityEventHandler



Public	

int	 groupID
	 Switch	Group	ID,	as	defined	in	WwiseID.cs.	

int	 valueID
	 Switch	Value	ID,	as	defined	in	WwiseID.cs.	
const	int	 MAX_NB_TRIGGERS	=	32

	 Since	our	mask	is	a	32	bits	integer,	we	can't	have	more
than	32	triggers.	

List<	int	>	 triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}
	 List	containing	the	enabled	triggers.	

bool	 useOtherObject	=	false

	
This	property	is	usefull	only	when	used	with	colliders.
When	enabled,	the	target	of	the	action	will	be	the	other
colliding	object.	When	disabled,	it	will	be	the	current	object.



Static	Public	

static	Dictionary<	uint,	string	>	 triggerTypes	=AkTriggerBase.GetAllDerivedTypes	()

	
Will	contain	the	types	of	all	the	triggers
derived	from	AkTriggerBase	at
runtime.	



This	will	call	AkSoundEngine.SetSwitch()	whenever	the	selected	Unity
event	is	triggered.	For	example	this	component	could	be	set	on	a	Unity
collider	to	trigger	when	an	object	enters	it.

:
Integration	Details	-	Switches	(Note:	This	is	described	in	the
Wwise	SDK	documentation.)
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	AkTerminator



This	script	deals	with	termination	of	the	Wwise	audio	engine.	It	must	be
present	on	one	Game	Object	that	gets	destroyed	last	in	the	game.	It	must
be	executed	AFTER	any	other	monoBehaviors	that	use	AkSoundEngine.

:
Terminate	the	Different	Modules	of	the	Sound	Engine	(Note:
This	is	described	in	the	Wwise	SDK	documentation.)
AK::SoundEngine::Term()	(Note:	This	is	described	in	the	Wwise
SDK	documentation.)
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	AkTriggerBase
AkTriggerCollisionEnter,	AkTriggerCollisionExit,	AkTriggerDisable,
AkTriggerEnable,	AkTriggerEnter,	AkTriggerExit,	AkTriggerMouseDown,
AkTriggerMouseEnter,	AkTriggerMouseExit,		AkTriggerMouseUp



Public	

delegate	void	 Trigger	(GameObject	in_gameObject)
	 Delegate	declaration	for	all	Wwise	Triggers.	



Public	

Trigger	 triggerDelegate	=	null

	 All	components	reacting	to	the	trigger	will	be	registered	in	this
delegate.	



Base	class	for	the	generic	triggering	mechanism	for	Wwise	Integration.
All	Wwise	components	will	use	this	mechanism	to	drive	their	behavior.
Derive	from	this	class	to	add	your	own	triggering	condition,	as	decribed	in
Adding	New	Triggers	for	Wwise	Events
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AK::Wwise::BaseType
AK::Wwise::AcousticTexture
AK::Wwise::AuxBus
AK::Wwise::Bank
AK::Wwise::BaseGroupType

AK::Wwise::State
AK::Wwise::Switch

AK::Wwise::Event
AK::Wwise::RTPC
AK::Wwise::Trigger

AK::Wwise::CallbackFlags
AkAudioListener
AkBank
AkCallbackManager
AkEmitterObstructionOcclusion
AkEnvironment
AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
AkEnvironmentPortal
AkEvent

AkAmbient
AkEventCallbackMsg
AkGameObj
AkInitializer
AkMemBankLoader
AkRoom
AkRoomPortal
AkRoomPortalObstruction
AkSpatialAudioEmitter
AkSpatialAudioListener
AkState
AkSurfaceReflector
AkSwitch
AkTerminator
AkTriggerBase
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a b c d e g h i l m p r s t u v w

-	a	-

AcousticTexture	:	AkSurfaceReflector
actionOnEventType	:	AkEvent
AddGeometrySet()	:	AkSurfaceReflector
AddListener()	:	AkGameObj
axis	:	AkEnvironmentPortal

-	b	-

bankName	:	AkBank	,	AkMemBankLoader
basePath	:	AkInitializer

-	c	-

callbackManagerBufferSize	:	AkInitializer
ClosePortal()	:	AkRoomPortal
curveInterpolation	:	AkEvent

-	d	-

decodeBank	:	AkBank
defaultPoolSize	:	AkInitializer
diffractionFlags	:	AkInitializer

-	e	-

enableActionOnEvent	:	AkEvent
engineLogging	:	AkInitializer
eventID	:	AkEvent



ExecuteAction()	:	AK::Wwise::Event

-	g	-

GetAuxSendValueForPosition()	:	AkEnvironmentPortal
GetForward()	:	AkGameObj
GetID()	:	AkRoomPortal	,	AkRoom
GetPosition()	:	AkGameObj
GetUpward()	:	AkGameObj
groupID	:	AkSwitch	,	AkState

-	h	-

HandleEvent()	:	AkBank	,	AkRoomPortal

-	i	-

info	:	AkEventCallbackMsg
isEnvironmentAware	:	AkGameObj
isLocalizedBank	:	AkMemBankLoader

-	l	-

language	:	AkInitializer
loadAsynchronous	:	AkBank
LoadLocalizedBank()	:	AkMemBankLoader
LoadNonLocalizedBank()	:	AkMemBankLoader
lowerPoolSize	:	AkInitializer

-	m	-

m_positionOffsetData	:	AkGameObj
MAX_ROOMS_PER_PORTAL	:	AkRoomPortal
maxSoundPropagationDepth	:	AkInitializer
memoryCutoffThreshold	:	AkInitializer
monitorPoolSize	:	AkInitializer
monitorQueuePoolSize	:	AkInitializer



-	p	-

Post()	:	AK::Wwise::Event
PostCallbacks()	:	AkCallbackManager
PostMIDI()	:	AK::Wwise::Event
preparePoolSize	:	AkInitializer
priority	:	AkRoom

-	r	-

reflectAuxBus	:	AkSpatialAudioEmitter
reflectionMaxPathLength	:	AkSpatialAudioEmitter
reflectionsAuxBusGain	:	AkSpatialAudioEmitter
reflectionsOrder	:	AkSpatialAudioEmitter
RemoveGeometrySet()	:	AkSurfaceReflector
RemoveListener()	:	AkGameObj
reverbAuxBus	:	AkRoom
reverbLevel	:	AkRoom
roomReverbAuxBusGain	:	AkSpatialAudioEmitter
rooms	:	AkRoomPortal

-	s	-

saveDecodedBank	:	AkBank
sender	:	AkEventCallbackMsg
SetBGMCallback()	:	AkCallbackManager
SetMonitoringCallback()	:	AkCallbackManager
soundEmitterObject	:	AkEvent
spatialAudioPoolSize	:	AkInitializer
StopMIDI()	:	AK::Wwise::Event
streamingPoolSize	:	AkInitializer

-	t	-

transitionDuration	:	AkEvent
Trigger()	:	AkTriggerBase
triggerDelegate	:	AkTriggerBase



-	u	-

UnloadBank()	:	AkBank
unloadTriggerList	:	AkBank

-	v	-

valueID	:	AkState	,	AkSwitch

-	w	-

wallOcclusion	:	AkRoom
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

uint	AK::Wwise::Event::Post ( GameObject	 gameObject

Posts	this	Event	on	a	GameObject.

:
gameObject	 The	GameObject

:
Returns	the	playing	ID.
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::PostMIDI ( GameObject	
AkMIDIPostArray	
)

Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
array	 The	array	of	AkMIDIPost	that	are	posted.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

string	AkInitializer::basePath	=	AkSoundEngineController.s_DefaultBasePath

Path	for	the	soundbanks.	This	must	contain	one	sub	folder	per	platform,	with	the
same	as	in	the	Wwise	project.
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AkCallbackManager

PostCallbacks
SetBGMCallback
SetMonitoringCallback

static	void	AkCallbackManager::SetMonitoringCallback

Call	this	to	set	a	function	to	call	whenever	Wwise	prints	a	message	(warnings	or	errors).
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

void	AkMemBankLoader::LoadNonLocalizedBank

Load	a	sound	bank	from	WWW	object.
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AkCallbackManager

PostCallbacks
SetBGMCallback
SetMonitoringCallback

static	void	AkCallbackManager::SetBGMCallback

Call	this	to	set	a	iOS	callback	interruption	function.	By	default	this	callback	is	not	defined.
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A	|	B	|	C	|	E	|	R	|	S	|	T

		A		 AkEnvironmentPortal

AcousticTexture	(AK::Wwise)			

AkAmbient			 AkEventCallbackMsg

AkAudioListener			

AkBank			

AkCallbackManager			 AkMemBankLoader

AkEmitterObstructionOcclusion			

AkEnvironment			

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm			
A	|	B	|	C	|	E	|	R	|	S	|	T
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AkCallbackManager

PostCallbacks
SetBGMCallback
SetMonitoringCallback

static	int	AkCallbackManager::PostCallbacks

This	function	dispatches	all	the	accumulated	callbacks	from	the	native
sound	engine.	It	must	be	called	regularly.	By	default	this	is	called	in
AkInitializer.cs.
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AK::Wwise::AcousticTexture	
AK::Wwise::AcousticTexture
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AK::Wwise::AuxBus	
AK::Wwise::AuxBus
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AK::Wwise::Bank	
AK::Wwise::Bank
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AK::Wwise::BaseGroupType	
AK::Wwise::BaseGroupType
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AK::Wwise::BaseType	
AK::Wwise::BaseType
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AK::Wwise::CallbackFlags	
AK::Wwise::CallbackFlags
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AK::Wwise::Event	
AK::Wwise::Event

ExecuteAction(GameObject	gameObject,
AkActionOnEventType	actionOnEventType,
int	transitionDuration,	AkCurveInterpolation
curveInterpolation)

AK::Wwise::Event [inline]

Post(GameObject	gameObject) AK::Wwise::Event [inline]
Post(GameObject	gameObject,
CallbackFlags	flags,
AkCallbackManager.EventCallback
callback,	object	cookie=null)

AK::Wwise::Event [inline]

Post(GameObject	gameObject,	uint	flags,
AkCallbackManager.EventCallback
callback,	object	cookie=null)

AK::Wwise::Event [inline]

PostMIDI(GameObject	gameObject,
AkMIDIPostArray	array) AK::Wwise::Event [inline]

PostMIDI(GameObject	gameObject,
AkMIDIPostArray	array,	int	count) AK::Wwise::Event [inline]

StopMIDI(GameObject	gameObject) AK::Wwise::Event [inline]
StopMIDI() AK::Wwise::Event [inline]
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

uint	AK::Wwise::Event::Post ( GameObject	
CallbackFlags	
AkCallbackManager.EventCallback	
object	
)

Posts	this	Event	on	a	GameObject.

:
gameObject	 The	GameObject
flags	
callback	
cookie	 Optional	cookie	received	by	the	callback

:
Returns	the	playing	ID.
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

uint	AK::Wwise::Event::Post ( GameObject	
uint	
AkCallbackManager.EventCallback	
object	
)

Posts	this	Event	on	a	GameObject.

:
gameObject	 The	GameObject
flags	
callback	
cookie	 Optional	cookie	received	by	the	callback

:
Returns	the	playing	ID.
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::ExecuteAction ( GameObject	
AkActionOnEventType	
int	
AkCurveInterpolation	
)

Executes	various	actions	on	this	event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
actionOnEventType	
transitionDuration	
curveInterpolation	
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::PostMIDI ( GameObject	
AkMIDIPostArray	
int	
)

Posts	MIDI	Events	on	this	Event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
array	 The	array	of	AkMIDIPost	that	are	posted.
count	 The	number	of	elements	from	the	array	that	will	be	posted.
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::StopMIDI ( GameObject	 gameObject

Stops	MIDI	Events	on	this	Event	associated	with	a	GameObject.

:
gameObject	 The	GameObject
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AK::Wwise::Event

ExecuteAction
Post
Post
Post
PostMIDI
PostMIDI
StopMIDI
StopMIDI

void	AK::Wwise::Event::StopMIDI ( 	)	 [inline]

Stops	all	MIDI	Events	on	this	Event.
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AK::Wwise::RTPC	
AK::Wwise::RTPC
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AK::Wwise::State	
AK::Wwise::State
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AK::Wwise::Switch	
AK::Wwise::Switch
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AK::Wwise::Trigger	
AK::Wwise::Trigger
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AkAmbient	
AkAmbient

actionOnEventType AkEvent
curveInterpolation AkEvent
enableActionOnEvent AkEvent
eventID AkEvent
soundEmitterObject AkEvent
transitionDuration AkEvent
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

int	AkEvent::eventID	=	0

ID	of	the	Event	as	found	in	the	WwiseID.cs
file.
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

GameObject	AkEvent::soundEmitterObject

Game	object	onto	which	the	Event	will	be	posted.	By
default,	when	empty,	it	is	posted	on	the	same	object
on	which	the	component	was	added.
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

bool	AkEvent::enableActionOnEvent	=	false

Enables	additional	options	to	reuse	existing
events.	Use	it	to	transform	a	Play	event	into	a
Stop	event	without	having	to	define	one	in	the
Wwise	Project.
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

AkActionOnEventType	AkEvent::actionOnEventType

Replacement	action.	See	AK::SoundEngine::ExecuteEventOnAction().
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

AkCurveInterpolation	AkEvent::curveInterpolation

Fade	curve	to	use	with	the	new	Action.	See	AK::SoundEngine::ExecuteEventOnAction().
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AkEvent

actionOnEventType
curveInterpolation
enableActionOnEvent
eventID
soundEmitterObject
transitionDuration

float	AkEvent::transitionDuration	=	0.0f

Duration	of	the	fade.	See
AK::SoundEngine::ExecuteEventOnAction().
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AkSwitch

groupID
valueID

const	int	AkUnityEventHandler::MAX_NB_TRIGGERS	=	32

Since	our	mask	is	a	32	bits	integer,	we	can't	have	more	than	32	triggers.
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AkSwitch

groupID
valueID

List<int>	AkUnityEventHandler::triggerList	=	new	List<int>()	{	START_TRIGGER_ID	}

List	containing	the	enabled	triggers.
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AkSwitch

groupID
valueID

bool	AkUnityEventHandler::useOtherObject	=	false	[inherited]

This	property	is	usefull	only	when	used	with	colliders.	When
enabled,	the	target	of	the	action	will	be	the	other	colliding	object.
When	disabled,	it	will	be	the	current	object.
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AkSwitch

groupID
valueID

Dictionary<uint,	string>	AkUnityEventHandler::triggerTypes	=	AkTriggerBase.GetAllDerivedTypes	()

Will	contain	the	types	of	all	the	triggers	derived	from	AkTriggerBase
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AkAudioListener	
AkAudioListener
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AkBank	
AkBank

bankName AkBank
decodeBank AkBank
HandleEvent(GameObject	in_gameObject) AkBank [inline]

loadAsynchronous AkBank
saveDecodedBank AkBank
UnloadBank(GameObject	in_gameObject) AkBank [inline]

unloadTriggerList AkBank
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

override	void	AkBank::HandleEvent ( GameObject	

Loads	the	SoundBank.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

void	AkBank::UnloadBank ( GameObject	 in_gameObject

Unloads	a	SoundBank.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

string	AkBank::bankName	=	""

Name	of	the	SoundBank,	as	specified	in	the
Wwise	project.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

bool	AkBank::loadAsynchronous	=	false

Check	this	to	load	the	SoundBank	in	the
background.	Be	careful,	if	Events	are	triggered
and	the	SoundBank	hasn't	finished	loading,
you'll	have	"Event	not	found"	errors.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

bool	AkBank::decodeBank	=	false

Decode	this	SoundBank	upon	load.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

bool	AkBank::saveDecodedBank	=	false

Save	the	decoded	SoundBank	to	disk	for	faster
loads	in	the	future.
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AkBank

bankName
decodeBank
HandleEvent
loadAsynchronous
saveDecodedBank
UnloadBank
unloadTriggerList

List<int>	AkBank::unloadTriggerList	=	new	List<int>()	{AkUnityEventHandler.DESTROY_TRIGGER_ID	}

Reserved.
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AkCallbackManager	
AkCallbackManager

PostCallbacks() AkCallbackManager [inline,
static]

SetBGMCallback(BGMCallback	in_CB,	object
in_cookie) AkCallbackManager [inline,

static]

SetMonitoringCallback(AK.Monitor.ErrorLevel
in_Level,	MonitoringCallback	in_CB) AkCallbackManager [inline,

static]
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AkEmitterObstructionOcclusion	
AkEmitterObstructionOcclusion
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AkRoomPortalObstruction

LayerMask	AkObstructionOcclusion::LayerMask	=	-1	[inherited]

Indicates	which	layers	act	as	obstructers/occluders.
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AkRoomPortalObstruction

float	AkObstructionOcclusion::refreshInterval	=	1	[inherited]

The	number	of	seconds	between	obstruction/occlusion	checks.
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AkRoomPortalObstruction

float	AkObstructionOcclusion::fadeTime	=	0.5f	[inherited]

The	number	of	seconds	for	fade	ins	and	fade	outs.
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AkRoomPortalObstruction

float	AkObstructionOcclusion::maxDistance	=	-1.0f	[inherited]

The	maximum	distance	at	which	to	perform	obstruction/occlusion.	A
negative	value	will	be	interpreted	as	inifinite	distance.
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AkEnvironment	
AkEnvironment
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AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm

AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
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AkEnvironmentPortal	
AkEnvironmentPortal

axis AkEnvironmentPortal
GetAuxSendValueForPosition(Vector3
in_position,	int	index) AkEnvironmentPortal [inline]
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AkEnvironmentPortal

axis
GetAuxSendValueForPosition

float	AkEnvironmentPortal::GetAuxSendValueForPosition

The	axis	used	to	find	the	contribution	of	each	environment.
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AkEnvironmentPortal

axis
GetAuxSendValueForPosition

Vector3	AkEnvironmentPortal::axis

The	array	is	already	sortet	by	position.	The	first	environment
is	on	the	negative	side	of	the	portal(opposite	to	the	direction
of	the	chosen	axis)	The	second	environment	is	on	the
positive	side	of	the	portal
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AkEvent	
AkEvent

actionOnEventType AkEvent
curveInterpolation AkEvent
enableActionOnEvent AkEvent
eventID AkEvent
soundEmitterObject AkEvent
transitionDuration AkEvent
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AkEventCallbackMsg	
AkEventCallbackMsg

info AkEventCallbackMsg
sender AkEventCallbackMsg
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AkEventCallbackMsg

info
sender

GameObject	AkEventCallbackMsg::sender

AkSoundEngine.PostEvent	callback	flags.	See	the
AkCallbackType	enumeration	for	a	list	of	all	callbacks.
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AkEventCallbackMsg

info
sender

AkCallbackInfo	AkEventCallbackMsg::info

GameObject	from	whom	the	callback	function	was	called.
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AkGameObj	
AkGameObj

AddListener(AkAudioListener	listener) AkGameObj [inline]

GetForward() AkGameObj [inline,
virtual]

GetPosition() AkGameObj [inline,
virtual]

GetUpward() AkGameObj [inline,
virtual]

isEnvironmentAware AkGameObj
m_positionOffsetData AkGameObj
RemoveListener(AkAudioListener
listener) AkGameObj [inline]
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

bool	AkGameObj::AddListener ( AkAudioListener

Adds	an	AkAudioListener	to	the	container	of	listeners	listening	to	this
gameobject.

:
listener	

:
Returns	true	if	the	listener	was	not	previously	in	the	list,	false
otherwise.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

bool	AkGameObj::RemoveListener ( AkAudioListener

Removes	an	AkAudioListener	from	the	container	of	listeners	listening	to	this
gameobject.

:
listener	

:
Returns	true	if	the	listener	was	previously	in	the	list,	false	otherwise.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

virtual	Vector3	AkGameObj::GetPosition (

Gets	the	position	including	the	position	offset,	if
applyPositionOffset	is	enabled.	User	can	also	override	this	method
to	calculate	an	arbitrary	position.

:
The	position.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

virtual	Vector3	AkGameObj::GetForward (

Gets	the	orientation	forward	vector.	User	can	also	override	this
method	to	calculate	an	arbitrary	vector.

:
The	forward	vector	of	orientation.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

virtual	Vector3	AkGameObj::GetUpward (

Gets	the	orientation	upward	vector.	User	can	also	override	this
method	to	calculate	an	arbitrary	vector.

:
The	upward	vector	of	orientation.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

AkGameObjPositionOffsetData	AkGameObj::m_positionOffsetData

When	not	set	to	null,	the	position	will	be	offset	relative	to	the	Game	Object
position	by	the	Position	Offset.
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AkGameObj

AddListener
GetForward
GetPosition
GetUpward
isEnvironmentAware
m_positionOffsetData
RemoveListener

bool	AkGameObj::isEnvironmentAware	=	true

Is	this	object	affected	by	Environment	changes?
Set	to	false	if	not	affected	in	order	to	save	some
useless	calls.	Default	is	true.
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AkInitializer	
AkInitializer

basePath AkInitializer
callbackManagerBufferSize AkInitializer
defaultPoolSize AkInitializer
diffractionFlags AkInitializer
engineLogging AkInitializer
language AkInitializer
lowerPoolSize AkInitializer
maxSoundPropagationDepth AkInitializer
memoryCutoffThreshold AkInitializer
monitorPoolSize AkInitializer
monitorQueuePoolSize AkInitializer
preparePoolSize AkInitializer
spatialAudioPoolSize AkInitializer
streamingPoolSize AkInitializer
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

string	AkInitializer::language	=	AkSoundEngineController.s_Language

Language	sub-folder.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::defaultPoolSize	=	AkSoundEngineController.s_DefaultPoolSize

Default	Pool	size.	This	contains	the	meta	data	for	your	audio	project.	Default	size	is	4
MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::lowerPoolSize	=	AkSoundEngineController.s_LowerPoolSize

Lower	Pool	size.	This	contains	the	audio	processing	buffers	and	DSP	data.	Default
size	is	2	MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::streamingPoolSize

Streaming	Pool	size.	This	contains	the	streaming	buffers.	Default	size	is	1	MB,	but	you
should	adjust	for	your	needs.

Wwise	Unity	IntegrationMon	Jan	8	10:46:18	2018		 	1.6.3

http://www.doxygen.org/index.html


AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::preparePoolSize	=	AkSoundEngineController.s_PreparePoolSize

Prepare	Pool	size.	This	contains	the	banks	loaded	using	PrepareBank	(Banks	decoded
on	load	use	this).	Default	size	is	0	MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

float	AkInitializer::memoryCutoffThreshold

This	setting	will	trigger	the	killing	of	sounds	when	the	memory	is	reaching	95%	of	capacity.	Lowest	priority
sounds	are	killed.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::monitorPoolSize	=	AkSoundEngineController.s_MonitorPoolSize

Monitor	Pool	size.	Size	of	the	monitoring	pool,	in	bytes.	This	parameter	is	not	used	in
Release	build.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::monitorQueuePoolSize

Monitor	Queue	Pool	size.	Size	of	the	monitoring	queue	pool,	in	bytes.	This	parameter	is	not	used	in
Release	build.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::callbackManagerBufferSize

CallbackManager	buffer	size.	The	size	of	the	buffer	used	per-frame	to	transfer	callback	data.	Default	size	is	4
KB,	but	you	should	increase	this,	if	required.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

int	AkInitializer::spatialAudioPoolSize

Spatial	Audio	Lower	Pool	size.	Default	size	is	4	MB,	but	you	should	adjust	for	your	needs.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

uint	AkInitializer::maxSoundPropagationDepth

Spatial	Audio	Max	Sound	Propagation	Depth.	Maximum	number	of	rooms	that	sound	can	propagate	through;	must
be	less	than	or	equal	to	AK_MAX_SOUND_PROPAGATION_DEPTH.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

AkDiffractionFlags	AkInitializer::diffractionFlags

Enable	or	disable	specific	diffraction	features.	See	AkDiffractionFlags.
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AkInitializer

basePath
callbackManagerBufferSize
defaultPoolSize
diffractionFlags
engineLogging
language
lowerPoolSize
maxSoundPropagationDepth
memoryCutoffThreshold
monitorPoolSize
monitorQueuePoolSize
preparePoolSize
spatialAudioPoolSize
streamingPoolSize

bool	AkInitializer::engineLogging	=	AkSoundEngineController.s_EngineLogging

Enable	Wwise	engine	logging.	Option	to	turn	on/off	the	logging	of	the	Wwise	engine.
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AkMemBankLoader	
AkMemBankLoader

bankName AkMemBankLoader
isLocalizedBank AkMemBankLoader
LoadLocalizedBank(string
in_bankFilename) AkMemBankLoader [inline]

LoadNonLocalizedBank(string
in_bankFilename) AkMemBankLoader [inline]
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

void	AkMemBankLoader::LoadLocalizedBank

Load	a	language-specific	bank	from	WWW	object.
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

string	AkMemBankLoader::bankName	=	""

Name	of	the	bank	to	load.
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AkMemBankLoader

bankName
isLocalizedBank
LoadLocalizedBank
LoadNonLocalizedBank

bool	AkMemBankLoader::isLocalizedBank

Is	the	bank	localized	(situated	in	the	language
specific	folders).
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AkRoom	
AkRoom

GetID() AkRoom [inline]

priority AkRoom
reverbAuxBus AkRoom
reverbLevel AkRoom
wallOcclusion AkRoom
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

ulong	AkRoom::GetID ( 	)	 [inline]

Access	the	room's	ID.
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

AK.Wwise.AuxBus	AkRoom::reverbAuxBus

The	reverb	auxiliary	bus.
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

float	AkRoom::reverbLevel	=	1

The	reverb	control	value	for	the	send	to	the	reverb
aux	bus.
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AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

float	AkRoom::wallOcclusion	=	1

Occlusion	level	modeling	transmission	through
walls.

Wwise	Unity	IntegrationMon	Jan	8	10:46:18	2018		 	1.6.3

http://www.doxygen.org/index.html


AkRoom

GetID
priority
reverbAuxBus
reverbLevel
wallOcclusion

int	AkRoom::priority	=	0

In	cases	where	a	game	object	is	in	an	area	with	two
rooms,	the	higher	priority	room	will	be	chosen	for
AK::SpatialAudio::SetGameObjectInRoom()	The
higher	the	priority	number,	the	higher	the	priority	of
a	room.
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AkRoomPortal	
AkRoomPortal

ClosePortal(GameObject	in_gameObject) AkRoomPortal [inline]
GetID() AkRoomPortal [inline]
HandleEvent(GameObject	in_gameObject) AkRoomPortal [inline]
MAX_ROOMS_PER_PORTAL AkRoomPortal
rooms AkRoomPortal
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

ulong	AkRoomPortal::GetID ( 	)	 [inline]

Access	the	portal's	ID.
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

override	void	AkRoomPortal::HandleEvent

Opens	the	portal	on	trigger	event.

Wwise	Unity	IntegrationMon	Jan	8	10:46:18	2018		 	1.6.3

http://www.doxygen.org/index.html


AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

void	AkRoomPortal::ClosePortal ( GameObject	

Closes	the	portal	on	trigger	event.
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

const	int	AkRoomPortal::MAX_ROOMS_PER_PORTAL

AkRoomPortals	can	only	connect	a	maximum	of	2	rooms.
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AkRoomPortal

ClosePortal
GetID
HandleEvent
MAX_ROOMS_PER_PORTAL
rooms

AkRoom	[]	AkRoomPortal::rooms	=	new	

The	front	and	back	rooms	connected	by	the	portal.	The	first	room	is	on	the	negative
side	of	the	portal(opposite	to	the	direction	of	the	local	Z	axis)	The	second	room	is	on
the	positive	side	of	the	portal.
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AkRoomPortalObstruction	
AkRoomPortalObstruction
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AkSpatialAudioEmitter	
AkSpatialAudioEmitter

reflectAuxBus AkSpatialAudioEmitter
reflectionMaxPathLength AkSpatialAudioEmitter
reflectionsAuxBusGain AkSpatialAudioEmitter
reflectionsOrder AkSpatialAudioEmitter
roomReverbAuxBusGain AkSpatialAudioEmitter
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

AK.Wwise.AuxBus	AkSpatialAudioEmitter::reflectAuxBus

The	Auxiliary	Bus	with	a	Reflect	plug-in	Effect	applied.
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

uint	AkSpatialAudioEmitter::reflectionsOrder

The	maximum	number	of	reflections	that	will	be
processed	for	a	sound	path	before	it	reaches	the
listener.	Reflection	processing	grows	exponentially
with	the	order	of	reflections,	so	this	number	should
be	kept	low.	Valid	range:	1-4.
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

float	AkSpatialAudioEmitter::reflectionsAuxBusGain

The	gain	[0,	1]	applied	to	the	reflect	auxiliary	bus.
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

float	AkSpatialAudioEmitter::reflectionMaxPathLength

The	maximum	path	length	a	sound	path	can	have	from	the	emitter
to	the	listener	after	reflecting	on	surfaces.
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AkSpatialAudioEmitter

reflectAuxBus
reflectionMaxPathLength
reflectionsAuxBusGain
reflectionsOrder
roomReverbAuxBusGain

float	AkSpatialAudioEmitter::roomReverbAuxBusGain

Send	gain	(0.f-1.f)	that	is	applied	when	sending	to	the	aux	bus
associated	with	the	room	that	the	emitter	is	in.
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AkSpatialAudioListener	
AkSpatialAudioListener
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AkState	
AkState

groupID AkState
valueID AkState
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AkState

groupID
valueID

int	AkState::groupID

State	Group	ID,	as	defined	in	WwiseID.cs.
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AkState

groupID
valueID

int	AkState::valueID

State	Value	ID,	as	defined	in	WwiseID.cs.
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AkSurfaceReflector	
AkSurfaceReflector

AcousticTexture AkSurfaceReflector
AddGeometrySet(AK.Wwise.AcousticTexture
acousticTexture,	MeshFilter	meshFilter) AkSurfaceReflector [inline,

static]

RemoveGeometrySet(MeshFilter	meshFilter) AkSurfaceReflector [inline,
static]
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AkSurfaceReflector

AcousticTexture
AddGeometrySet
RemoveGeometrySet

static	void	AkSurfaceReflector::AddGeometrySet

Sends	the	mesh	filter's	triangles	and	their	acoustic	texture	to	Spatial	Audio.

:
acousticTexture	
meshFilter	
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AkSurfaceReflector

AcousticTexture
AddGeometrySet
RemoveGeometrySet

static	void	AkSurfaceReflector::RemoveGeometrySet

Remove	the	corresponding	mesh	filter's	geometry	from	Spatial	Audio.

:
meshFilter	
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AkSurfaceReflector

AcousticTexture
AddGeometrySet
RemoveGeometrySet

AK.Wwise.AcousticTexture	AkSurfaceReflector::AcousticTexture

All	triangles	of	the	component's	mesh	will	be	applied	with	this	texture.
The	texture	will	change	the	filter	parameters	of	the	sound	reflected
from	this	component.
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AkSwitch	
AkSwitch

groupID AkSwitch
valueID AkSwitch
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AkSwitch

groupID
valueID

int	AkSwitch::groupID

Switch	Group	ID,	as	defined	in	WwiseID.cs.
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AkSwitch

groupID
valueID

int	AkSwitch::valueID

Switch	Value	ID,	as	defined	in	WwiseID.cs.
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AkTerminator	
AkTerminator
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AkTriggerBase	
AkTriggerBase

Trigger(GameObject	in_gameObject) AkTriggerBase
triggerDelegate AkTriggerBase
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AkTriggerBase

Trigger
triggerDelegate

delegate	void	AkTriggerBase::Trigger ( GameObject	

Delegate	declaration	for	all	Wwise	Triggers.

:

in_gameObject	
in_gameObject	is	used	to	pass	"Collidee"	objects
when	Colliders	are	used.	Some	components	have	the
option	"Use	other	object",	this	is	the	object	they'll	use.
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AkTriggerBase

Trigger
triggerDelegate

Trigger	AkTriggerBase::triggerDelegate	=	null

All	components	reacting	to	the	trigger	will	be
registered	in	this	delegate.
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AddGeometrySet()	:	AkSurfaceReflector
AddListener()	:	AkGameObj
ClosePortal()	:	AkRoomPortal
ExecuteAction()	:	AK::Wwise::Event
GetAuxSendValueForPosition()	:	AkEnvironmentPortal
GetForward()	:	AkGameObj
GetID()	:	AkRoomPortal	,	AkRoom
GetPosition()	:	AkGameObj
GetUpward()	:	AkGameObj
HandleEvent()	:	AkBank	,	AkRoomPortal
LoadLocalizedBank()	:	AkMemBankLoader
LoadNonLocalizedBank()	:	AkMemBankLoader
Post()	:	AK::Wwise::Event
PostCallbacks()	:	AkCallbackManager
PostMIDI()	:	AK::Wwise::Event
RemoveGeometrySet()	:	AkSurfaceReflector
RemoveListener()	:	AkGameObj
SetBGMCallback()	:	AkCallbackManager
SetMonitoringCallback()	:	AkCallbackManager
StopMIDI()	:	AK::Wwise::Event
Trigger()	:	AkTriggerBase
UnloadBank()	:	AkBank
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a b c d e g i l m p r s t u v w

	

-	a	-

AcousticTexture	:	AkSurfaceReflector
actionOnEventType	:	AkEvent
axis	:	AkEnvironmentPortal

-	b	-

bankName	:	AkBank	,	AkMemBankLoader
basePath	:	AkInitializer

-	c	-

callbackManagerBufferSize	:	AkInitializer
curveInterpolation	:	AkEvent

-	d	-

decodeBank	:	AkBank
defaultPoolSize	:	AkInitializer
diffractionFlags	:	AkInitializer

-	e	-

enableActionOnEvent	:	AkEvent
engineLogging	:	AkInitializer
eventID	:	AkEvent

-	g	-



groupID	:	AkState	,	AkSwitch

-	i	-

info	:	AkEventCallbackMsg
isEnvironmentAware	:	AkGameObj
isLocalizedBank	:	AkMemBankLoader

-	l	-

language	:	AkInitializer
loadAsynchronous	:	AkBank
lowerPoolSize	:	AkInitializer

-	m	-

m_positionOffsetData	:	AkGameObj
MAX_ROOMS_PER_PORTAL	:	AkRoomPortal
maxSoundPropagationDepth	:	AkInitializer
memoryCutoffThreshold	:	AkInitializer
monitorPoolSize	:	AkInitializer
monitorQueuePoolSize	:	AkInitializer

-	p	-

preparePoolSize	:	AkInitializer
priority	:	AkRoom

-	r	-

reflectAuxBus	:	AkSpatialAudioEmitter
reflectionMaxPathLength	:	AkSpatialAudioEmitter
reflectionsAuxBusGain	:	AkSpatialAudioEmitter
reflectionsOrder	:	AkSpatialAudioEmitter
reverbAuxBus	:	AkRoom
reverbLevel	:	AkRoom
roomReverbAuxBusGain	:	AkSpatialAudioEmitter
rooms	:	AkRoomPortal



-	s	-

saveDecodedBank	:	AkBank
sender	:	AkEventCallbackMsg
soundEmitterObject	:	AkEvent
spatialAudioPoolSize	:	AkInitializer
streamingPoolSize	:	AkInitializer

-	t	-

transitionDuration	:	AkEvent
triggerDelegate	:	AkTriggerBase

-	u	-

unloadTriggerList	:	AkBank

-	v	-

valueID	:	AkState	,	AkSwitch

-	w	-

wallOcclusion	:	AkRoom

Wwise	Unity	IntegrationMon	Jan	8	10:46:17	2018		 	1.6.3

http://www.doxygen.org/index.html

	Wwise Unity Integration
	リリースノート
	新機能2017.2
	重要な移行の注意 2017.2
	新機能2017.1
	重要な移行の注意 2017.1

	Unityプロジェクトのインテグレーションの、インストールとアップグレード
	前提条件
	Wwise Integration Packageを初めてインストールする
	Unityプロジェクトに対して実行される変更点
	サウンドをゲームにインテグレートする
	SoundBankはどこにおくべきか？
	プラグインの追加
	Wwise Integration Packageを新しいバージョンにアップデート・アップグレードする

	Wwise Integration Packageをアンインストールする
	Wwise Unity Integrationの使用
	Wwise Picker
	Wwise Types
	Adding New Triggers for Wwise Events
	Wwise Timeline Integration

	Build your Unity Game for a Target Platform
	Android用にビルドする
	Build for iOS
	Linux用にビルドする
	UnityでWwiseのカスタムプラットフォームを使う

	WwiseとUnityでDLCをつくる
	Build the Native Integration Plug-in from Source
	Build Log
	プラグインのC++コードを更新した後に、Wwise Integration Packageを新しいバージョンにアップデート・アップグレードする

	APIの変更と制約
	プラットフォーム別の情報
	Background Mode (Android)
	OBBファイルを使う (Android)
	Audio Session Interruptions (iOS)
	Windows Store Apps Specific Information

	Licensing (Free & Commercial)
	Wwiseデモシーン
	Using UnityでWwise Spatial Audioを使う
	Preparation for the Spatial Audio Tutorials
	Surface Reflectors Tutorial
	Rooms and Portals Tutorial
	Obstruction and Occlusion

	トラブルシューティング

	マルチアーキテクチャプラットフォーム向けにアプリケーションをビルドする
	構成
	AK::Wwise::AcousticTexture
	AK::Wwise::AuxBus
	AK::Wwise::Bank
	AK::Wwise::BaseGroupType
	AK::Wwise::BaseType
	AK::Wwise::CallbackFlags
	AK::Wwise::Event
	AK::Wwise::RTPC
	AK::Wwise::State
	AK::Wwise::Switch
	AK::Wwise::Trigger
	AkAmbient
	AkAudioListener
	AkBank
	AkCallbackManager
	AkEmitterObstructionOcclusion
	AkEnvironment
	AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
	AkEnvironmentPortal
	AkEvent
	AkEventCallbackMsg
	AkGameObj
	AkInitializer
	AkMemBankLoader
	AkRoom
	AkRoomPortal
	AkRoomPortalObstruction
	AkSpatialAudioEmitter
	AkSpatialAudioListener
	AkState
	AkSurfaceReflector
	AkSwitch
	AkTerminator
	AkTriggerBase

	クラス階層
	AK::Wwise::BaseType
	AK::Wwise::AcousticTexture
	AK::Wwise::AuxBus
	AK::Wwise::Bank
	AK::Wwise::BaseGroupType
	AK::Wwise::State
	AK::Wwise::Switch

	AK::Wwise::Event
	AK::Wwise::RTPC
	AK::Wwise::Trigger

	AK::Wwise::CallbackFlags
	AkAudioListener
	AkBank
	AkCallbackManager
	AkEmitterObstructionOcclusion
	AkEnvironment
	AkEnvironment::AkEnvironment_CompareBySelectionAlgorithm
	AkEnvironmentPortal
	AkEvent
	AkAmbient

	AkEventCallbackMsg
	AkGameObj
	AkInitializer
	AkMemBankLoader
	AkRoom
	AkRoomPortal
	AkRoomPortalObstruction
	AkSpatialAudioEmitter
	AkSpatialAudioListener
	AkState
	AkSurfaceReflector
	AkSwitch
	AkTerminator
	AkTriggerBase

	構成メンバ

